CATIA Version 5 FreeStyle Shaper is a powerful modeling tool used to dynamically design all types of surface elements, from the stylist's drawing to the final surface, ready for the manufacturing processes.

Using this product you can generate free form 3D curves and surfaces from scratch, and dynamically deform and analyze all produced elements.

Using the FreeStyle Optimizer you can create and modify curve and surface shapes based on other elements such as digitized data.

The CATIA - FreeStyle Shaper & Optimizer User's Guide has been designed as an aid to using both the FreeStyle Shaper and FreeStyle Optimizer by themselves, but also in conjunction with other CATIA Version 5 workbenches.
Preferred Road Maps

This User's Guide is intended for the user who need to become quickly efficient with the CATIA Version 5 FreeStyle Shaper and FreeStyle Optimizer before reading it, you should be familiar with the basic CATIA Version 5 concepts, such as the document windows, standard toolbars and menus.

To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter first of all and the Workbench Description to find his way around the FreeStyle Shaper workbench.

User's familiar with the product should browse the Table of Contents rapidly, then move on directly to specific sections of interest to them: curve and surface creation, edition, and analysis. More advanced users, and those using the FreeStyle Optimizer will find an Advanced Tasks and Customizing chapters that should answer their needs.
Where to Find More Information

Prior to reading this book, we recommend that you read the CATIA Version 5 Infrastructure User's Guide that describes generic capabilities common to all CATIA Version 5 products. It also describes the general layout of CATIA V5, and interoperability between workbenches.

Also read the CATIA V4 Integration documentation that presents interfaces with standard exchange formats and most of all with CATIA V4 data.
What's New?

This table identifies what new or improved capabilities have been documented in Version 5 Release 3 of the CATIA FreeStyle Shaper and the CATIA FreeStyle Optimizer.

**Curve creation and modification:**
Enhanced interface for curve creation, whether curves on planes or on surfaces
Enhanced creation capability: projection curves
Enhanced curve edition capabilities
Modification of the curve extension capability
Enhanced curve segmentation and reflect curve analysis capabilities
New creation capability by approximating procedural curves

**Surface creation and modification:**
Enhanced match, offset, extrude surfaces
Enhanced modification capability by extending surfaces and improved control points edition
Modification of planar patch creation and surface global deformation
New creation capability by approximating procedural surfaces, diassembling and segmenting surfaces

**Analysis tools:**
Enhanced analysis types: draft analysis, mapping analysis, curvature analysis, cutting planes analysis and analysis using isophotes
Modified connect checker and distance analysis capabilities

**Generic Tools:**
New control points and isoparametrics display capabilities
New compass management toolbar for quick compass orientation
Enhanced Autodetection capability

**Interoperability with the Wireframe Workbench:**
New wireframe geometry creation capabilities: creating lines, points, planes and circles.
Getting Started

The following tutorial aims at giving you a feel of what you can do with CATIA - FreeStyle Shaper & Optimizer. It provides a step-by-step scenario showing you how to use key capabilities.

The main tasks proposed in the chapter are:

- Starting the FreeStyle Workbench
- Creating a First Surface
- Editing the Surface
- Creating a Blend between two Surfaces
- Applying a Global Deformation

![Tasks]

All together, this scenario should take about 15 minutes to complete.

The final surface element will look like this:
Starting the FreeStyle Workbench

The first task will show you how to enter the FreeStyle Shaper workbench.

The only pre-requisites for this task is to have a current CATIA V5 session running.

1. Choose FreeStyle from the Start menu.
The FreeStyle Shaper workbench is displayed and ready to use.

If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the View -> Specifications Visible menu item.
Up

Editing the Surface

Starting the FreeStyle Workt

Creating a First Surface

Creating a Blend between two

Applying a Global Deformatic
Creating a First Surface

The first task will show you how to:

- Activate the 3D compass
- Create a single-patch planar surface.

1. Select the Planar patch icon

   The 3D compass is displayed in the document and looks like this:

   This 3D compass gives a reference plane (indicated by the green arrows) or a direction (indicated by the red arrow).

   This compass is usually displayed when creating or modifying an element.

   See Creating Planar Patches for further details on the 3D compass capabilities.

2. Right-click in the document and choose the Edit Orders item from the contextual menu.

   You can now define the degree of the mono-patch surface along U and V from the Orders dialog box.

3. Click Close when finished defining these parameters.
4. Click anywhere in the workbench, and drag the mouse.

   A surface outline appears as you drag the pointer, one of its corner located where you clicked in the document.

   Two values are displayed on the outline, indicating the length and width of the patch.

   ![Surface Outline]

   Use the Ctrl-click capability if you want the middle of the patch to be centered on the axis origin, that is centered around the point you clicked.

5. When you have reached the adequate size, click again.

   The corresponding surface has been created in a plane parallel to that defined by the 3D compass.
Editing the Surface

This task will show you how to modify the surface you just created.

1. Select the surface.

2. Click the Control Points icon.

As soon as you clicked the icon, control points and mesh lines are displayed. They are used to manually pull on the surface so as to deform it.

Deformation can also be done using the Tuner dialog box displayed using the Edit contextual command on control points or mesh lines. The Control Points dialog box is also displayed:

Use it to define the type of operation to be performed on the control points.

- Support defines the type of translation to be applied.
Law defines the type of deformation that is to be applied when several control points have been selected.

Here, choose the Translation along local normals and Bell law options.

3. Move the cursor onto one of the control points or mesh lines. Arrows automatically appear. They represent the directions in which you can perform a deformation.

4. Move onto the center mesh line and pull the bottom arrow down.

The selected control points are moved according to the translation type and law defined in the Control Points dialog box.

Here, the surface is deformed along the line in a bell shape.

5. Click the Translation in the plane and Stretch selected points options in the Control Points dialog box, click a control point, and pull outward on one of the displayed arrows.

The surface is dynamically modified

By default all control points and mesh lines are selected. Click a specific point to deform the surface at this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection capabilities). The same applies to mesh lines.
6. Click OK in the Control Points dialog box to accept the modified shape of the surface.
Creating a Blend between two Surfaces

In this task you learn to blend two surfaces, that is create one surface connecting both initial surfaces, while specifying the continuity type.

1. Click the 4 Points Patch icon in the Surface Creation menu to create another surface.
2. Successively click the four corner points of the first surface. The second surface is created.
3. Select the new surface, right-click to display the contextual menu, and choose the Properties menu item to display the Properties dialog box.
4. Click the arrow in the Color chooser from the Fill area, and choose another color to better distinguish the newly created surface from the initial one.

5. Click the More... button to display more properties.
6. Click OK in this dialog box. The newly created surface is clearly identifiable.

7. Move to the compass. When the pointer changes to a cross, press and hold while dragging the compass onto the new surface.
8. Move the pointer over the horizontal X axis till it becomes red, and glide the surface away from the first one. Repeat this operation with gliding the surface down along the vertical Z axis, then grab the compass center and bring the compass over the 3-axis system at the bottom right-corner of the document. The compass is set back to its default position.

9. Click the Freeform Blend Surface icon . The blend Options dialog box displays.

10. Select the edge of the initial surface closest to the second surface. The boundary is highlighted.

11. Select the edge of the second surface closest to the initial surface. A blend surface is automatically computed.

12. Click OK in the Blend Options dialog box to validate the blend surface. Here we changed its color to blue, using the contextual menu and Properties dialog box, to see it better.
Applying a Global Deformation

This command is only available when using FreeStyle Optimizer.

Now that both surfaces are linked, you want to modify all three surfaces according to a modification pattern you define in space, keeping all defined curvature continuities.

1. Press and hold the Ctrl-key, then successively select all three surfaces.

2. Click the Global Deformation icon.

The 3D compass is displayed along with the Global Deformation dialog box into which you can specify deformation options: using an intermediate patch or an axis use. In this case, use the default option: Intermediate surface use.

3. Click Run in the Global Deformation dialog box to accept the deformation parameter definition. The Control Points dialog box displays.

A patch with control points and mesh lines is displayed. It represents the planar patch, defined in the plane indicated by the compass, equivalent to the same bounding box as the selected surfaces.
4. Use the control points and the mesh lines of the planar patch to deform it. The space transformation is defined between the initial patch and the deformed patch.

All surfaces are automatically and dynamically deformed according to this intermediate patch deformation.

5. Do not change the options and click OK in the dialog box. The final deformed surface looks like this.
Basic Tasks

Theme

- Opening a New CATPart Document
- Importing and Exporting Files
- Creating and Managing Curves
- Creating and Managing Surfaces
- Analyzing Curves and Surfaces
- Generic Tools
Opening a New CATPart Document

This task shows how to open a new CATPart document and activate the FreeStyle Shaper workbench.

1. Select the File -> New commands (or click the New icon).
   
   The New dialog box is displayed, allowing you to choose the type of the document you need.

2. Select Part in the List of Types field and click OK.
3. Choose FreeStyle from the Start menu.

The FreeStyle Shaper workbench is loaded and a CATPart document is opened.
The FreeStyle Shaper workbench document is made of:
- the specification tree and the geometry area in the main window
- specific toolbars (geometry creation and modification toolbars, analysis toolbar)
- a number of contextual commands available in the specification tree and in the geometry.
  Remember that these commands can also be accessed from the menu bar.

The specification tree is a unique specification-driven and generative tool, which captures and reuses process specifications, ultimately accelerating the design process. It lets you concentrate the design effort on establishing the proper design specifications, while leaving it to the system to compute or update the resulting geometry when required. This specification tree can be customized using the Tools --> Options menu item, Tree tab.

If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the View --> Specifications menu item.

You could also directly choose FreeStyle from the Start menu. It would automatically open a new CATPart document.
CATIA Version 5 includes unique two-way interoperability with CATIA Version 4 data, thus allowing CATIA Version 5 to benefit from the breadth of the CATIA Solutions Version 4 portfolio.

CATIA Version 5 data can be loaded and processed in a CATIA Version 4 session. Similarly, CATIA Version 4 data can be read in a CATIA Version 5 session and converted to a CATIA Version 5 format for further edition.


3D data exchange and more specifically surfaces exchange between CATIA Version 5 and other CAD systems can be done through Initial Graphics Exchange Specification (IGES) format.

These exchanges are documented in the CATIA.Infrastructure User’s Guide (Importing and Exporting Files), as they are not specific to the FreeStyle Shaper workbench, but rather to the .CATPart document type.

Therefore, refer to this chapter for a description of the specific surface elements that can be imported from or exported to the IGES Standard.
Creating and Managing Curves

This chapter deals with curve creation and management using the FreeStyle Shaper workbench.

Creating Free Form Curves on Plane

Creating Free Form Curves on Surfaces

Creating Free Form Curves in Space

Projecting Curves

Editing Curves Using Control Points

Creating Blend Curves

Matching Curves

Extending Curves

Creating a Symmetric Curve

Segmenting Curves

Trimming Curves

Smoothing Curves
Approximating Procedural Curves
Creating Free Form Curves on Plane

This task explains how to create curves on a virtual plane.

Open a new .CATPart document by choosing Shape -> FreeStyle from the Start menu.

1. Click the Curve on Plane icon.

2. Use the 3D compass to define the plane in which the curve is to be created, or select one of the document pre-defined planes.

Right-click the 3D compass to display more orientation options (see Creating Planar Patches).

3. Define the curve creation mode using the Planar Curve dialog box: the curve can be created by interpolation or smoothing.
   - If you choose to use the Through Points mode, the resulting curve is a multi-arc curve passing through each selected point.
   - If you choose the Near Points mode, the resulting curve is a single-arc, with a set degree and smoothed through the selected points.
   - If you choose the Control Points mode, the points you click are the control points of the resulting curve, as if you were using the editing capabilities (see Editing Curves Using Control Points).

   - If you click the closure icon, you can create a closed curve.

The curve properties will be updated as you create the curve.
You can choose one of the three display options:

- Click the Porcupine Analysis icon if you want to display a porcupine analysis
- Click the Hides or shows grid icon to display or hide the planar grid
- Click the third icon to display the distance between points and curve (only in Near Points mode)

4. Click anywhere in the document to define the first end point of the curve. You can click in space or on existing geometry.

A dot is displayed where you clicked and a rubberband bounding box appears when you move the pointer.

5. Click as many times as needed to create points through which the curve must pass. The curve and its bounding box are previewed as you move the pointer around.

6. Double-click, or click OK in the dialog box, to create the end point of the curve. The curve has been created in the plane you previously defined, and can now be used for other purposes, such as performing operations on curves, analysis purposes, extruding surfaces, and so forth.
When using the Control Points creation option, you can create a mono-arc curve up to six points, then if there are more than six points, the system automatically generates a multi-arc curve.

As soon as you click the first point, the plane can no longer be modified.

You cannot create closed curves.

You can create curves symmetrically in relation to a specific angle from the creation plane:

- Click the Mirror Symmetry icon from the Planar Curve dialog box.
  
  An axis is displayed lying on the creation plane and passing through the first point. The displayed value is the angle value in relation to this plane.

b. Right-click the angle value to edit it via the Angle Tuner dialog box and press Enter.
  
  You could also directly modify the angle and the axis origin using the manipulators.

c. Move the pointer where you wish to click the second point. The symmetric curve is previewed.

d. Proceed as for a regular curve.
Creating Free Form Curves on Surfaces

This task explains how to create trimming curves on a surface. Two types of curves are available for creation: freeform curves passing through all points you click, or isoparametric curves. These curves must start and end on the edges of the surface, and lie on the surface.

Open any document containing a surface from the online/Samples/freestyle directory.

1. Click the Curve on Surface icon.

2. Select the surface on which the curve is to be created.

The Options dialog box is displayed letting you choose between the curve creation mode: by interpolation or smoothing.

- If you choose to use the Through Points mode, the resulting curve is a multi-arc parametric curve passing through each selected point.
- If you choose the Control Points mode, the points you click are the control points of the resulting parametric curve, as if you were using the editing capabilities (see Editing Curves Using Control Points).

This is the default value.

- If you choose the Near Points mode, the resulting curve is a single-arc parametric curve, with a set degree and smoothed through the selected points.
3. Choose the Through points option and click the edge of the selected surface, or move the pointer over the surface if the Autodetection mode (F12) is active.

A red dot is displayed identifying the starting point location on the surface edge.

4. Click as many locations as you wish the curve to go through.

Green dots are displayed where you clicked, and the curve is previewed as you move the pointer around.

5. Click the edge of the surface to create the end point of the curve.

The curve has been created on the selected surface, following its shape.

You can modify the shape of the curve at any time while it is being created, by moving the pointer above any of the creation points and pulling on the manipulators (manipulators option in the Curve dialog box).

6. Click OK to create the curve.
The surface can now be used for other purposes, such as trimming the surface.

7. Click the Break icon and select an area delimited by one of the curves to trim the initial surface.

Any surface can be used, whether planar or previously deformed.

- Check the Order option from the dialog box to display the curve order that you can edit at any time by right-clicking the order value located at the curve starting point, and choosing a new value. If you choose the Control Points option, the number of points within the surface (excluding those points on the edges) is based on the order number. If you have an order number set to 5, only three points can be clicked within the surface.

- Check the Number of points option to display the points where you click

To create a tangent curve:

a. use the With control points option and click the first two points on the surface edge (parametric line).

b. continue creating the curve as usual

c. if you wish to make it tangent on both sides of the surface, proceed by clicking two points on the other edge

d. finish as usual, by clicking the last point on the surface edge.
This is especially useful when breaking a surface. The surface edge present a tangency continuity.

- You can create only one curve at a time on the surface, however, once you have trimmed the surface and removed a section of the surface, you can create another curve on the same surface. The remaining section is considered as a new element.
- Use the Manipulators (arrows) to modify the curve as it is created. To fine-tune the manipulators, right-click and choose Attenuate. The attenuation lets you define the ratio between the mouse displacement and the actual displacement of the manipulator. This attenuation factor is saved in the CATIA settings.

- To facilitate the edge detection, for example, use the remote autodetection capability. To do this simply click the Autodetection icon, press F12, or use the Insert -> Autodetection menu item, and define the options in the Autodetection dialog box:
You can detect for the selected element:
- the closest border (edge) by clicking the Closest border icon
- the closest corner by clicking the Closest corner icon
- the closest segment or control point by clicking the Closest control point icon

You can automatically snap one of these closest elements by detecting the Snap option.

Finally, activate the corresponding option to dynamically display:
- the point coordinates as the pointer moves along by clicking the Coordinates checkbox
- the remote mode by clicking the Search dressing checkbox: in Control Points only, activates the control point network display
Creating Free Form Curves in Space

This task explains how to create curves in space. These are defined by specific points lying on pre-existing geometric elements.

Open the curveinspace.CATPart document from the online/Samples/freestyle directory.

1. Click the Curve in Space icon.

   The Curve on Geometry dialog box is displayed.

2. Choose the type of curve creation:
   - If you choose to use the Through Points mode, the resulting curve is a multi-arc curve passing through each selected point.
   - If you choose the Near Points mode, the resulting curve is a single-arc, with a set degree and smoothed through the selected points. This mode enables you to define the tangency at extremities for planar curves.
   - If you choose the Control Points mode, the points you click are the control points of the resulting curve, as if you were using the editing capabilities (see Editing Curves Using Control Points).
   - If you click the Closure icon, you can create a closed curve.

You can choose one of the three display options:
   - Click the Porcupine Analysis icon if you want to display a porcupine analysis
   - Click the Hides or shows grid icon to display or hide the planar grid
   - Click the third icon to display the distance between points and curve (only in Near Points mode)

3. Move the pointer close to the geometry on which you want the first point of the curve to lie and click.
4. Click as many locations as you wish the curve to go through.

Dots and manipulators are displayed on the geometry allowing you to modify the location of the starting point for the curve. Moreover, the curve is previewed as you move the pointer around.

5. Click OK to create the end point of the curve.

The curve has been created passing through key points on existing geometric elements.

When using the Control Points creation option, you can create a mono-arc curve up to six points, then if there are more than six points, the system automatically generates a multi-arc curve.

You cannot create closed curves.
Projecting Curves

This task explains how to project curves on surfaces.

Open the projectcurve.CATPart document from the online/Samples/freestyle directory.

1. Select a curve.
2. Click the Project Curve icon.
   The Projection dialog box is displayed.

3. Select the surface or set of surface on which the curve should be projected.
4. Choose the options from the Projection dialog box:
   - **Type**: to set the type of projection, either normal to the surface or according to the 3D compass.
   - **Tolerance**: to set the tolerance of the resulting curve on the surface, in relation to the exact projection curve.
   - **Mode**: to decide whether you keep or replace the initial element, and whether the resulting curve is limited onto the surface.
When the 3D Curve option is checked, the Keep option affects the curve only, i.e. the initial curve is kept or replaced. When the 3D Curve option is unchecked, the Keep option affects the surface only, i.e. the initial surface is kept or replaced.

If the curve is projected according to the compass current orientation (Projection mode set to Compass), the result would be:

![Projection mode set to Compass](image)

However, if the curve is projected according to the normal to the surface (Projection mode set to Normal), the result would be:

![Projection mode set to Normal](image)

5. Click OK in the Projection dialog box to create the projected curves. As we chose the projection according to the compass orientation, two curves are created on the surface, and show up in the specification tree as two different elements.

- Solid curves represent a projected curve cutting a surface, allowing the break of the surface (Relimit option).
- Dotted curves indicate that the break might not be possible.
- If the Relimit option is unchecked, a curve is created on the surface but will not allow surface breaking.
- When the 3D Curve option is unchecked, it is better to keep the value 15 for the maximum order (Order field) if there is no constraint: the system will optimize the order of the projected curve according to the entered tolerance.
- When you project a curve on two surfaces, there may be no tangent continuity.
Editing Curves Using Control Points

This task explains how to modify a curve using its control points.

Open the editcontrolpoints.CATPart document from the online/Samples/freestyle directory.

1. Select the curve you wish to edit.

2. Click the Control Points icon.

   Control points and lines are displayed, along with the 3D compass and the curve degree.

   By default all control points and mesh lines are selected. Click a specific point to deform the surface at this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection capabilities). The same applies to mesh lines.

3. Move the pointer over a point or a line.

   Arrows are displayed according to the Support and Law options active in the Control Points dialog box.
Support defines the type of translation to be applied.

Law defines the type of deformation that is to be applied when several control points have been selected.

4. Pull on the arrow matching the direction in which you want to deform the curve.

5. Activate the Remote control from the Control Points dialog box. Automatically, the control point closest to the pointer is selected and the direction in which you can pull as well. If the pointer is at the same distance from two control points, the Remote control option highlights the mesh lines between points.

6. Click More... in the Control Points dialog box, and activate the Numbers option.

   The value is displayed on the curve.

7. Use the contextual menu to choose the order number for the curve.
8. Move the pointer to a control point, right-click to display the contextual menu and choose the Edit item. The Tuner dialog box is displayed, letting you key in the exact position of the control point in space.

Use the Step field to decide by how much the Position values should be increased/decreased when using the spinners.

9. Click OK in the Control Points dialog box to validate the modifications.
Use the Control Points dialog box to modify the curve according to certain predefined laws.

Further modification options are available from the More... button of the Control Points dialog box:
- Freezing of the selected points (no other can be selected) and of the Support option
- Display of the order number and continuity type directly on the curve for edition using the contextual menu
- Dynamic display of the initial curve and of the delta as you pull on the control points.

Use the Remote Control capability when geometry is very small or difficult to select due to the presence of other elements preventing you from accessing the desired control point.

Use the Manipulators (arrows) to modify the curve as it is created.
- To fine-tune the manipulators, right-click and choose Attenuate. The attenuation lets you define the ratio between the mouse displacement and the actual displacement of the manipulator. This attenuation factor is saved in the CATIA settings.
- To snap a point onto external geometry, either a surface corner, a pad vertex, or a curve end-point, choose the Snap on Geometry option
  - Select the control point(s) or mesh lines to be moved
  - Right-click the manipulator, and choose the Snap on Geometry option
  - Click and drag the control point over the point used as a reference for the snapping
  - Release the mouse button.
  The control point snaps onto the projection of the reference point according to the support.
  Using the Ctrl key you can snap onto the exact point.
- To perform a quick analysis of the mesh line inflection, choose the Inflections checkbox.
- You cannot move unselected points unless no point is selected.
Creating Blend Curves

This task explains how to create blend curves. Blending means that a connecting curve will be created between two selected curves, taking certain continuity, position and tension constraints into account.

Open the blendcurve.CATPart document from the online/Samples/freestyle directory.

1. Select two curves.

2. Click the Blend Curve icon.

3. Select the second curve, in case you have not previously selected it.

   The blend curve is automatically previewed. By default it connects the curves at their end points closest to the selectioned points.

4. Define the display of blending parameters in the Blend Options dialog box.
   By default the continuities and contact points are displayed and two texts indicating which continuity type is taken into account are present on the curves.
   The default continuity type is C2 (curvature continuous blend).
5. Move the pointer over the texts on end points, and right-click to display the contextual menu allowing you to modify the connection point.

You can do the same on the other end point.

6. To modify the position of a blend curve end-point, move the pointer close to this point.

Provided the Contact Points option is active, manipulators are displayed, letting you interactively define a new position, either by clicking or clicking and dragging.

7. Activate the Tension option and modify the tension by sliding the displayed value along the green segment.

This segment represents the direction and limits of the blend curve tangent at its end points.
8. You can also edit the value, or invert the tension direction, using the contextual menu on the value.

9. Select the Split Curves option. This option lets you split the curve at the contact points between the initial curves and the blend curve. This later allows the use of the Break capability on the curve to remove one side of initial curve. The split will be effective only when the last step has been performed.

10. Once you are satisfied with the new curve, click OK in the Blend Options dialog box. The blend curve is computed.
11. Click the Break icon and select the section of the curve to be removed.
It is deleted.

- The curve resulting from the blend remains selected by default. If you wish to perform analyses, make sure you select the other curves using the Ctrl-key.
- Some curves cannot be split, even though the Split Curves option is checked, if you select the edge of a surface, the end-points or a curve, or an already split curve.
Matching Curves

This task explains how to match curves.

Open the matchcurve.CATPart document from the online/Samples/freestyle directory.

1. Select the curve you wish to match to another curve.

2. Click the Match Curve icon.

3. Select the second curve to be matched.

   The first curve is automatically modified so as to be connected to the second curve while taking the continuity type into account.

4. From the Match Options dialog box choose the options you wish to visualize on the geometry: the continuities, the tension and the contact points at each end-point.

   Once these options are displayed, they can be interactively modified.

5. Activate the Continuities option to display the continuity boxes.

6. Right-click these boxes to choose from the point, tangency or curvature continuity type to be taken into account.
7. Activate the Tension option to display the tension manipulator, and modify the tension by sliding the displayed value along the green segment.

This segment represents the direction and limits of the match curve tangent at its end-points.

8. Activate the Contact Point option to display the point manipulators and to move the points along the curve, thus interactively redefining the connection location.

9. Activate the Quick Analysis option to check the quality of the connection between the match curve and the target curve.

Depending on the type of continuity connection, three values can be displayed:

a. the distance (mm): the maximum distance between the two curves
b. the angle (degrees) between the tangents to the curves
c. the curvature (%): that is the ratio between both element
These values are dynamically updated as you modify the contact point position, the continuities or the tension values.

10. Check the Split Curve option. This option lets you split the curve at the contact point between both curves. This later allows the use of the Break capability on the curve to remove one side of matched curve. The split will be effective only when the last step has been performed.

11. Click OK to created the matched curve as it is previewed.

12. Click the Break icon and select the section of the curve to be removed. It is deleted.
The curve resulting from the match remains selected by default. If you wish to perform analyses, make sure you select the other curve using the Control key.

Some curves cannot be split, even though the Split Curve option is checked, if you select the edge of a surface, the end-points or a curve, or an already split curve.
Extending Curves

This task explains how to modify a curve by extension, that is by modification of its length. It can be a positive or negative extension meaning that you can actually lengthen or shorten the curve.

Open the extend.CATPart document from the online/Samples/freestyle directory.

1. Select the curve to be extended.
   It will be extended on the end-point side closest to the selection point.

2. Click the Extend icon .

The Extension dialog box is displayed, in which you can choose the type of extension to be applied: Tangential or Parametric.

3. Click the Tangential option:
   The curve is extrapolated taking into account the keyed in length (expressed in model units).
   Here we keyed in 100.
   If you key in a negative value, the resulting curve is created in the other direction.
4. Click the Parametric option:
The curve is extended in relation to the keyed in percentage.
When the value is positive, the last segment (defined by the arc limits) is made longer.
In the example, the last segment is lengthened by 100% (maximum extension percentage).
However if the keyed in value is negative, the curve is shortened.
In the example, the curve is shortened by 50% (the maximum shortening percentage is -95%).

5. Click OK to create the extended curve.
   - In Tangential and Parametric mode, you can also use the manipulators to interactively modify the value.
   - In Parametric mode, you can choose to keep the initial curve, or not (Keep option).
   - The curvilinear length of the extension is displayed.
Creating a Symmetric Curve

This task explains how to create a symmetric curve with respect to a symmetry plane. The initial curve can be replaced or duplicated.

Open the analysis.CATPart document from the online/Samples/freestyle directory. This task can be performed with any existing curve.

1. Select the curve to be duplicated symmetrically:
2. Click the Mirror Symmetry icon.

3. Press and hold the Ctrl-key and select the symmetry plane either in the geometry or in the specification tree. It can be a predefined plane, or the plane passing through the point indicating the pointer location, and the 3D compass current plane.

As soon as the plane is selected, a curve symmetric to the initial curve has been created.

- If you do not press and hold the Ctrl key, the curve is not duplicated but replaced.
- Other elements can be symmetrically duplicated or replaced: surface (see Creating a Symmetric Surface) but also elements created using the Part Design workbench, such as points, lines, planes, or even cloud of points and so forth.
Smoothing Curves

This task explains how to smooth curves.

Open the smoothcurve.CATPart document from the online/Samples/freestyle directory.

1. Select the curve to be smoothed.

2. Click the Control Points icon.

   Control points are displayed on the curve, and the Control Points dialog box appears.

3. Define the smooth weight using the slider, and click Smooth.

   The curve is smoothed according to the value.

4. Click again to repeat the smoothing operation.

5. Once you are satisfied with the smoothed curve obtained, click OK in the Control Points dialog box.

You do not need to select the whole curve. You can locally smooth the curve. Simply use the multi-selection capabilities:

- Press and hold down the Shift-key and click on a first point. Still maintaining the Shift-key down, click another point of the curve. All points selected between the two selected points are selected as well, and the curve is smoothed in this area only.
Click a first point, press and hold down the Ctrl-key, then move on to the other points to be selected. Only the explicitly selected points are highlighted, and smoothing is performed on these points only.
Trimming Curves

This task explains how to trim curves if the Split curve option has been activated when creating blend or match curves (see Creating Blend Curves and Matching Curves).

Open the trimcurve.CATPart document from the online/Samples/freestyle directory.

1. Click the Break icon.

2. Select the curve you wish to trim.
   The curve is immediately trimmed at the splitting point.

You can use one of these two modes:
- Relimit
- Exact

If you select the curve at the splitting point, two curves are created. If you select one of the curve segments, this segment is deleted.
Segmenting Curves

This task explains how to modify the number of arcs (segments) on a NUPBS curve.

Open the segment.CATPart document from the online/Samples/freestyle directory.

1. Select the curve to be segmented.
2. Click the Segmentation icon.

The Segmentation - Approximation dialog box is displayed allowing you to define the segmentation according to a set number of segments or to a tolerance.

On the selected curves, segments are delimited by the points that are displayed.

The displayed value is the deviation between the initial curve and the previsualized curve.
3. Click on More to display more options:
   - Check the Information option to display information on the deviation or on the number of segments.
   - Check the Control Points option to display control points.
   - The Smooth option enables you to smooth control points.

   The values displayed on the curve are dynamically updated. Define the number of segments that you wish on the curve. The curve display and deviation value are dynamically updated.

   If you check the tolerance, the system automatically optimizes the numbers of segments to comply with the tolerance.

4. Click OK.
   The curve modification is taken into account.

The multi-selection of curves is available and enables you to apply a global segmentation on the selected curves (in Tolerance mode, these curves will have the same number of segments). However, you cannot mix the segmentation of curves and surfaces. You need to perform their segmentation separately.
Approximating Procedural Curves

In this task you will learn how to convert curves into NUPBS (Non Uniform Polynomial B-Spline) curves.

Open the approxim.CATPart document from the online/Samples/freestyle directory.

1. Select the curve to be approximated.

2. Click the Segmentation icon

   The Segmentation - Approximation dialog box is displayed allowing you to define the approximation according to a tolerance.

   When you select a procedural curve, the Type switches to Approximation.

   On the selected curves, segments are delimited by the points that are displayed.

   The displayed value is the deviation between the initial curve and the previsualized curve.
3. Click More... to display more options:
   - Check the Information option to display information on the deviation or the number of segments.
   - Check the Control Points option to display control points.
   - The Smooth option enables you to smooth control points.

   The values displayed on the curve are dynamically updated. The curve display and deviation value are dynamically updated.

   The system automatically optimizes the numbers of segments to comply with the tolerance.

4. Click OK.
   The curve modification is taken into account.

Muti-selection of curves is available. However, you cannot mix the approximation of curves and surfaces. You need to perform their approximation separately.
Creating and Managing Surfaces

This chapter deals with surface creation and management using the FreeStyle Shaper workbench.

Creating Planar Patches

Creating a Surface from Three Points

Creating a Surface from Four Points

Creating a Surface on an Existing Surface

Creating Blend Surfaces

Creating Styling Fillets

Matching Surfaces

Filling in Between Surfaces

Offsetting Surfaces

Smoothing Surfaces

Extending a Surface

Extruding a Surface

Segmenting Surfaces

Redefining Surface Limits

Restoring a Surface

Approximating Procedural Surfaces
Diassembling Surfaces

Up

Opening a New CATPart Do Importing and Exporting Files

Creating and Managing Curves Creating and Managing Surfaces Analyzing Curves and Surfaces

Generic Tools
Creating Planar Patches

This task explains how to create planar patches, that is planar surfaces.

Open a new .CATPart document.

1. Click the Planar Patch icon.

The 3D compass is displayed in the document and looks like this:

The solid planes of the 3D compass indicate in what plane any action is to be performed.

By default the creation plane is the XY plane. However, you can right-click the compass to display other options:

   a. Make XZ the Privileged Plane: elements are created in the XZ plane
   b. Make YZ the Privileged Plane: elements are created in the YZ plane
   c. Make Privileged Plane Most Visible: the plane in which elements are created is the plane seen most.

Keep the default working mode.
2. Click anywhere in the window.

An outline appears and evolves as you move the pointer in the main window. Two values are displayed indicating the length and width of the patch.

- If you call the function when a plane is selected, the surface is created in the selected plane otherwise it is created as described in the following cases.
  - If the 3D compass is in the model, the surface is created in the plane defined by the base.
  - If the 3D compass is in the upper-right corner of the screen, the surface is created in the plane parallel to the compass base and passing through:
    - the origin of the model if the first point selected is in space
    - the first point selected on geometry
3. Right-click and choose Edit dimensions.
If you do not explicitly enter the dimensions of the surface, simply click again when you have reached the adequate size.

The planar patch is created.

- Once the first point is defined, right-click anywhere to edit the surface degree (in U and V) just like you did to edit the dimensions.
- Using the Ctrl-key, the planar patch is centered around the point corresponding to the initial click, otherwise, by default, this point corresponds to one corner or the patch.
Creating a Surface from Three Points

This task explains how to create surfaces by clicking three points in pre-existing geometry or space.

Open the patch3points.CATPart document from the online/Samples/freestyle directory.

1. Click the 3-Point Patch icon in the Surface Creation toolbar.

2. Successively click two points in space, or on already existing geometry.
   A line is displayed between these two points. It is one side of the rectangular patch, and a text indicates the exact length of the segment.

2. Drag the pointer.
   A planar patch is pre-visualized: the first two points making up one of its sides, the second length of this same patch being given by the distance between the first line and the normal projection from the pointer location onto the privileged plane (indicated by the compass) containing the first point.

You can also right-click to display the Edit Dimensions dialog box that allows you to define exactly the second length of the patch.
3. Click a third point to create the planar patch.

- Right-click to edit the surface orders (U and V) at any time during the creation.
- Use the Ctrl-key to create a patch symmetrically on each side of the segment defined by the first two points.
Creating a Surface from Four Points

This task explains how to create surfaces by clicking four points in pre-existing geometry and space.

Open the fourpointpatch.CATPart document from the online/Samples/freestyle directory.

1. Click the 4-Point Patch icon in the Surface Creation toolbar.

2. Click one of the curves.
   
   You can click anywhere on any curve, at the intersection of curves, or on any other element.

3. Successively click two other points on the pre-existing geometry. An outline is previewed, representing the surface as it is defined.
4. Click anywhere in the document to create the last point used in the surface definition. If you click in space, the patch is a planar patch that belongs to the plane defined by the first three points. If you click the fourth point on existing geometry, the resulting surface will not necessarily be planar.

5. Once all four points have been clicked, the corresponding surface is automatically created.
Creating a Surface on an Existing Surface

This task explains how to create a surface on an existing surface. The newly created surface will lie on the initial one.

Open the geomongeom.CATPart document from the online/Samples/freestyle directory.

1. Select an existing surface.
2. Click the Geometry Extraction icon.
3. Click on the surface, where you would like a corner of the new surface to be located.
   If you press the Ctrl-key while clicking, the surface is created symmetrically in relation to the initial surface center.
4. Drag to generate a rubberband matching the new surface.
5. Click once you are satisfied with the new surface as visualized.
6. A surface is created lying exactly on the initial surface:
As opposed to the creation of planar patches, you cannot define the surface orders (U and V) prior to or while creating the surface. The resulting surface orders are identical to those of the initial surface. However, these values can later be edited (see Editing Surfaces Using Control Points).

These surfaces, as any other surfaces, can be edited using the control points.

If you move the pointer to the edge of the initial surface, the new one will automatically snap on the initial boundary.

Similarly, you can create curves on an already existing curve. Using the Ctrl-key will then create a curve symmetrically in relation to the initial curve center.

See Creating Curves on Surfaces to find how to use the remote autodetection capability.
Editing Surfaces Using Control Points

This task explains how to modify a surface using control points and mesh lines.

Open the editcontrolpoints.CATPart document from the online/Samples/freestyle directory.

1. Select the surface.

2. Click the Control Points icon.

   The 3D.compass is displayed showing the privileged plane in which you are working when you are manipulating the surface.

As soon as you clicked the icon, control points and mesh lines are displayed. They are used to manually pull on the surface so as to deform it.

Deformation can also be done using the Tuner dialog box displayed using the contextual commands on control points or mesh lines.
The Control Points dialog box is displayed:

Use it to define the type of operation to be performed on the control points.

- Support defines the type of translation to be applied.
- Law defines the type of deformation that is to be applied when several control points have been selected.

Here, choose the Translation along the normal to the surface and Bell law options.

3. Move the pointer onto one of the control points or mesh lines. Manipulators automatically appear. They represent the directions in which you can perform a deformation.
4. Pull on the arrow matching the direction in which you want to deform the surface.

The surface follows the shape indicated by the mesh line or control point.

You can activate other support and law options and continue deforming the surface.

By default all control points and mesh lines are selected. Click a specific point to deform the surface at this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection capabilities). The same applies to mesh lines.

5. Click More... in the Control Points dialog box. Further modification options are available:

- Freezing of directions or of the selected points (no other can be selected)
Display of the order number and continuity type directly on the surface for edition using the contextual menu.

Dynamic display of the initial surface and of the delta as you pull on the control points.

Smoothing (refer to Smoothing Surfaces).

6. Click OK in the Control Points dialog box to validate the modifications. The surface is modified.
Click any specific point, or mesh line to deform the surface at this element only. By default, selected points are displayed in red, and are green when deselected.

Remote control capability: activate the remote icon to be able to automatically detect the control point closest to the pointer. In this case, any other contextual menu is no longer available.

Project: (available only with the Translation in the plane or Translation along a direction options).
Use this capability to project selected points according to the local 3D compass

1. Bring the 3D compass onto the surface
2. Choose the Translation in the plane or Translation along a direction option
3. Select a mesh line or a subset or control points (you can also select all points but in this case the whole surface is projected according to the compass)
4. Click Project.

Use the Manipulators (arrows) to modify the curve as it is created.

To fine-tune the manipulators, right-click and choose Attenuate. The attenuation lets you define the ratio between the mouse displacement and the actual displacement of the manipulator. This attenuation factor is saved in the CATIA settings.

To snap a point onto external geometry, either a surface corner, a pad vertex, or a curve end-point, choose the Snap on Geometry option

- Select the control point(s) or mesh lines to be moved
- Right-click the manipulator, and choose the Snap on Geometry option
- Click and drag the control point over the point used as a reference for the snapping
- Release the mouse button. The control point snaps onto the projection of the reference point according to the support.

Using the Ctrl-key you can snap onto the exact point.

- To perform a quick analysis of the mesh line inflection, choose the Inflections checkbox.
- You can not move unselected points unless no point is selected.
Manipulating Surfaces

This task explains how to move and translate surfaces independently from any other element in the document.

Open the manipulate.CATPart document from the online/Samples/freestyle directory.

1. Click the Select icon and select the surface you wish to move.
2. Point to the compass manipulation handle (the red square located on the privileged plane at the base of the compass). The cursor shape changes to a cross.
3. Drag and drop the compass over the surface you wish to move about. The compass now is displayed in green.

Make sure you choose to display the bounding box using the Display manipulation bounding box option from the Tools -> Options dialog box, Visualization tab to display the whole bounding box as shown below, not just the compass over the geometry.

3. Move the pointer over any bounding box boundary, and drag the surface where you wish to move it.
4. Pull along a horizontal axis to slide the surface to the right or to the left.
5. Pull along a vertical axis to move the surface up or down.

The displacement distance is displayed as you move the surface around.

6. Release the mouse-key.

The surface has moved to a new location.

For further details and general manipulation tasks refer to the CATIA-Infrastructure User's Guide: Manipulating Viewpoints Using the Mouse and Compass and Manipulating Objects Using the Mouse and Compass
Rotating a Surface

This task explains how to rotate surfaces independently from any other element in the document.

Open the manipulate.CATPart document from the online/Samples/freestyle directory.

1. Select the surface you wish to move.
2. Point to the compass manipulation handle (the red square located on the privileged plane at the base of the compass).
   The cursor shape changes to a cross.
2. Drag and drop the compass over the surface you wish to rotate.
   The compass now is displayed in green.

If you checked the option Display manipulation bounding box in the Visualization tab via the Tools->Options command, a box will appear around the selected surface.

3. Move the pointer over the arc of circle on the compass indicating the direction in which you want to rotate the surface.
   The arc of circle is highlighted.
3. Drag in the desired direction. The surface rotates within the plane indicated by the selected arc of circle.
4. Release the mouse-key. The surface is set to the new direction.

- The surface has rotated around an axis. However, this has not changed anything to any other element present in the document.
- Multi-selection, whether using a trap or the Ctrl-click, is available to rotate a set of elements.
Creating a Symmetric Surface

This task explains how to create a symmetric surface with respect to a symmetry plane. The initial surface can be replaced or duplicated.

Open the analysis.CATPart document from the online/Samples/freestyle directory. The task can be performed with any of the existing surfaces.

1. Select the surface to be duplicated symmetrically.
2. Click the Mirror Symmetry icon.

3. Press and hold the Ctrl-key and select the symmetry plane either in the geometry or in the specification tree. It can be a predefined plane, or the plane passing through the point indicating the pointer location, and the 3D compass current plane.

As soon as the plane is selected, a surface symmetric to the initial surface has been created.

- If you do not press and hold the Ctrl-key, the surface is not duplicated but replaced.
- A set of elements can be symmetrically duplicated just as well.
Creating Blend Surfaces

This task explains how to create a blend surface between two pre-existing surfaces.

1. Open the blendsurface.CATPart document from the online/Samples/freestyle directory.
2. Click the Blend Surface icon.
3. Move the pointer over one of the surfaces and click one of its edges.
4. Click the edge of the second surface.

The blend surface is previewed, and the Blend Options dialog box is displayed.

4. Define the blending parameters to be visualized on the geometry:
Continuity Connection: displays the continuity type identifier (Point, Cross Tangent, Proportional Tangent, or Curvature)
Information: displays the type of blend surface, along with the number of patches used to create the surface.
Coupling Points: displays coupling points and arrows allowing you to interactively move these points along the blend surface limit curves
Tangency Tension: displays tangent modification manipulators
Curvature Tension: displays curvature modification manipulators

5. Check the Coupling points option.

The points are highlighted on the selected surface, and arrows are displayed when you move the pointer over these points.

6. Click one of the point and drag along one of the arrows.

The blend surface is automatically relimited. This can be done on both surfaces.
7. Check the Continuity Connection in the dialog box.

8. Right-click the continuity type identifier and choose another continuity type.

   Here is what you get if you choose a point type continuity:
   Similarly, you can check the Tangency or Curvature Tension. Whichever you choose, simply drag the green triangle along the tension line to modify its value, or right-click the value to display the contextual menu allowing you to edit it via a dialog box or to invert these tensions.

9. Click OK in the Blend Options dialog box to create the blend surface. It remains selected, thus allowing to immediately analyze its connection to the other surfaces, for example.

Three modes are available to create blend surfaces:
   a. Auto: the system optimizes the creation of a mono-patch or multi-patch surface
   b. Basic: allowing the creation of a mono-patch surface
   c. Advanced: allowing the creation of a multi-patch surface.

The Project end points option allows linear projection of the smaller edge, if selected first, onto the smaller surface as shown to the left. To the right is the resulting blend without the Project end points option.
Creating Styling Fillets on Surfaces

This task explains how to create a fillet between two sets of surfaces.

Open the fillet.CATPart document from the online/Samples/freestyle directory.

1. Click the Styling Fillet icon.

   The Fillet Options dialog box is displayed.

2. Select a first surface or a set of surfaces.

   An arrow appears indicating the normal to the surface in which direction the fillet surface is to be created. Click this arrow to invert its direction.

   The display of this normal is set by default in the Fillet Options dialog box.

3. Select a second surface, or set of surfaces, and key in the surface radius.

   Here we increased the radius value to 30.

   By default, the normals are displayed (green arrows). Click an arrow to invert it.
4. Click Apply in the Fillet Options dialog box. The fillet surface is pre-visualized.

Click the More... button to display more fillet options.

Before creating the fillet, you can display a number of options on the fillet surface:

- **Continuity connection:** once displayed, right-click the text to choose another continuity type (point, tangent, proportional and curvature).
- **Coupling points:** displays manipulators allowing you to modify the fillet surface limits.
- **Normals:** displays the normals onto the support surfaces.
- **Information:** displays the type of created surface (basic or advanced) and the number of patches composing it.

5. Click OK to create the fillet between the initial surfaces.
You can modify the continuities between surfaces by activating the Continuity connection option from the dialog box and right-clicking the displayed text. Four continuity types are available:

- point
- tangency
- proportional
- curvature

You cannot create a fillet on a surface which limits have been modified using the break capability, except if you chose the exact option when breaking the surface.
Matching Surfaces

In this task you will learn how to match two surfaces, or a surface to a curve, that is extend one surface to come up to the other element, specifying the continuity between the two elements.

Some options are only available in FreeStyle Optimizer.

Open the matchsurface.CATPart document from the online/Samples/freestyle directory.

1. Click the Match Surface icon.

2. Select the edge of the surface to be matched.

   The boundary is highlighted. A constraint box is displayed on the other boundary, indicating the type of constraint to be kept when matching the surface.

   This constraint can be modified using the contextual menu.

3. Move the pointer onto the second surface.

   Possible boundaries for the match are highlighted as you move the pointer along.

4. Click the surface when the adequate boundary is highlighted.

   The match is automatically applied. The first surface is recomputed so as to be connected to the second surface.
5. Define the elements that should be visualized on the surface for modification purposes, using the Match Options dialog box.

Information on the match surface is displayed in the Match Options dialog box:
- Match type, either Auto, Analytic or Approximated (mathematical algorithm used as matchtype)
- Number of patches making up the surface
- Order displays the order of the surface to be matched

6. Check the Coupling points option.

Manipulators are displayed on the connection, allowing you to interactively define the match limits by simply sliding them along the target curve.

You can edit the coupling points by right-clicking to display the contextual menu and choosing the Edit item.

You can also use the Snap on Geometry option.

7. Check the Continuity connection option and right-click onto the identifier to edit the continuity constraint on the boundary of the match surface on the target element, using the contextual menu.

Available continuity types are: point, tangent and curvature.

In the example, we impose a tangency constraint on the target surface. We keep a point continuity on the initial surface.
8. Check the Global tension and local tangents option.
   a. Global tension: you can now edit the global tension value by sliding the value along the green segment representing the direction and limits of the match surface tangent at its middle-points.
   b. Local tangents: the manipulators enable you to manage local tangents using an angle and a tension. Some particular values are then available for an angle and a tension by displaying a contextual menu.
      - Right-click the tension value to enter a new value within the 0 to 1 range, using the Tension Tuner dialog box.
      - Right-click the local tangents to choose from:
        - a specific value you key in (User)
        - the first surface tangent (Initial)
        - the target element tangent (Target)

9. Check the Quick connect checker and degrees option: depending on the type of continuity connection, three values can be displayed:
   a. the distance (mm): the maximum distance between the two elements
   b. the angle (degrees) between the tangents to the surfaces
   c. the curvature (%): that is the ratio between both surface curvatures
10. Check the Control Points option to display the control points and mesh lines on the surface, allowing you to dynamically modify them. Click Run to recompute the match surface.

See Editing Surfaces Using Control Points to find more about available options.

When checked, the Diffusion option, propagates evenly any modification performed using the control points.

11. Click OK in the Match Options dialog box.

The Project end points option allows linear projection of the smaller edge, if selected first, onto the smaller surface as shown to the left. To the right is the resulting match without the Project end points option:

Options available only in FreeStyle Optimizer:
- Planar
- Control Points
In this task you will learn how to fill the space between three surfaces.

You can fill the space between three or more elements (up to nine). The elements can be either curves or any surface type element. These elements must be contiguous in only one point.

Open the fill.CATPart document from the online/Samples/freestyle directory.

1. Click the Fill icon.

2. Select the boundary of the first surface. The Fill Options dialog box is displayed allowing you to visualize the continuities and tensions where fill surfaces are connected to the initial surfaces if you wish.

3. Select the boundary of an adjacent surface.

4. Select the boundary of all other surfaces, still going from one surface to its direct neighbor.

Once you have selected the last boundary contiguous to the first selected surface, the filling surfaces are created.

Use the graphic properties to modify the colors of the filling surfaces to better identify them. To this end, select each surface either in the geometry or in the specification tree, and call the Properties dialog box; Graphic tab, and modify the Fill color.

You can fill the space between different types of elements. For example, select a curve, two surfaces supporting a blend surface and the blend itself. In this case, the intersections between the selected edges on the surfaces and the blend limits are automatically detected, and the filling surface created accordingly.
Similarly, you can fill three or more open-sided contours when composed of surface boundaries only. A temporary blend curve is created to close the contour when you click Apply, allowing the system to compute the filling surfaces.

You can also fill the space between two intersecting curves, or surfaces, forming an open angle. To do this, simply select these curves or surface boundaries, then click Apply in the Fill Option dialog box. The system automatically creates temporary curves matching the selected ones to close a contour before filling it.

- Make sure you select contiguous surface boundaries, especially when filling the space between more than three surfaces. Do not select boundaries randomly.
- If four edges have been selected, a mono-patch surface is created. However, if three, five or more edges (up to nine) have been selected, as many surfaces are created as selected edges.
- By default the created surfaces are tangent to initial surfaces and between each other. They also present a point continuity with any selected curve.
<table>
<thead>
<tr>
<th>Up</th>
<th>Planar Surfaces</th>
<th>3-Point Surface</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Point Surface</td>
<td>Surface on Existing Surface</td>
<td>Editing Surfaces</td>
</tr>
<tr>
<td>Manipulating Surfaces</td>
<td>Rotating Surfaces</td>
<td>Symmetric Surface</td>
</tr>
<tr>
<td>Bend Surfaces</td>
<td>Styling Fillets</td>
<td>Matching Surfaces</td>
</tr>
<tr>
<td>Fill Surfaces</td>
<td>Offsetting Surfaces</td>
<td>Smoothing Surfaces</td>
</tr>
<tr>
<td>Extending Surfaces</td>
<td>Approximating Procedural S</td>
<td>Extruding Surfaces</td>
</tr>
<tr>
<td>Segmenting Surfaces</td>
<td>Redefining Surface Limits</td>
<td>Restoring a Surface</td>
</tr>
<tr>
<td>Dismantling Surfaces</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Offsetting Surfaces

This task explains how to create an offset surface, based on an existing surface.

Open the offset.CATPart document from the online/Samples/freestyle directory.

1. Select a surface, or a set of surfaces.

2. Click the Offset icon.

   The offset surface is automatically visualized as a meshed surface.

3. Choose the options you wish from the Offset Options dialog box:
   - the offset type: a simple offset creates a surface which points are all at the same distance from the initial surface, whereas a variable offset lets you set the offset distance at each corner point of the surface.
   - the limits, that is constraints to be taken into account when computing the offset surface. You can specify whether it should comply with a given tolerance, or whether it should have a maximum order in U and V. The resulting surface will lie within these constraints.
   - whether the initial surface should be kept, or replaced
   - the type of information to be displayed on the offset surface before it actually is created. This information is useful to let you fine-tune the offset specifications.
     - Offset values: the distance between any point of the initial surface and the resulting surface.
     - Normals: identifying the direction of the initial surface
     - Information: the type of resulting surface, whether Basic (one-patch) or Advanced (several patches)
     - Order: the order value in U and V
     - Tolerance: the exact tolerance deviation
     - Corners: displays or hides the manipulators at the four corner points (only in Simple mode) to make Snap on Geometry possible. When you are in Variable mode, the Corners option is checked: if you pull the central manipulator, all manipulators are temporarily linked to each other.
4. Right-click the offset value box on the surface to display the Edit dialog box, and enter the offset value.

5. Click Close to validate the offset value.

You can also move the pointer over one of the corner points, and directly pull on the displayed manipulators. The offset value is dynamically modified.

6. Click OK in the Offset Options dialog box to create the offset surface.

You can also create variable offset:

   . Click Variable in the Offset Options dialog box.
b. You can modify the delta in order. This means that the maximum order number of the offset surface will not exceed the initial surface order number plus the indicated value.

Offset values are displayed at each corner of the surface.

c. Move the pointer over a corner point and drag it in the desired direction to dynamically modify the value.

d. Right-click another offset value and using the Edit dialog box, change this value. Here we modified two values from 15 to 25.

e. Click OK in the Offset Options dialog box. The offset surface is created.

The same method applies when offsetting a set of surfaces. As all surfaces may not present the same orientation, check the Normals option from the Offset Options dialog box and right-click arrows: a contextual menu displays on each arrow and enables you to Reverse ou Adjust all.
If the offset is performed on a surface relimited using the break command, the result is a relimited surface, even though the pre-visualization presents the initial (not relimited surface):
Smoothing Surfaces

In this task you will learn how to smooth a surface.

Open the smooth.CATPart document from the online/Samples/freestyle directory.

1. Select the surface to be smoothed.

2. Click the Control Points icon

   Control points are displayed on the surface, and the Control Points dialog box appears.

3. Define the smooth weight, and click Run.

   The surface is smoothed according to the value.

4. Click again to repeat the smoothing operation if needed.

5. Once you are satisfied with the smoothed surface obtained, click OK in the Control Points dialog box.

You do not need to select the whole surface. You can choose at which point, or mesh line, the surface should be smoothed. Simply use the multi-selection capabilities:

- Press and hold down the Shift-key and click a first point. Still maintaining the Shift key down, click another point of the curve. All points selected between the two selected points are selected as well, and the surface is smoothed in this area only.

- Click a first point, press and hold down the Ctrl-key, then move on to the other points to be selected. Only the explicitly selected points are highlighted, and smoothing is performed on these points only.
Extending Surfaces

In this task you will learn how to extend a surface, that is make it bigger or smaller depending on which side of the manipulator you pull, or how to extrapolate a surface, that is add an extra surface to the initial one while taking continuity constraints into account.

Open the extend.CATPart document from the online/Samples/freestyle directory.

1. Select a surface boundary. A manipulator is displayed.

2. Click the Extend icon.

The Extension dialog box is displayed. Three options are available:

- **Tangential**: the surface is extended along the tangent to the surface on the selected boundary, and of a given distance (G1 continuity).
- **Curvature**: the surface is extrapolated by the specified value, complying with the surface curvature (G2 continuity). No manipulator is displayed.
- **Parametric**: the surface is extended according its initial parameterization. When the value is positive, the last row of segments (patches) is made longer. However if the value is negative, the surface is shortened.

The extension can
range from -95% to 100% of the initial surface.

3. Click Tangential and pull on the manipulator till you reach 60 in the Length field of the Extension dialog box. The extension is pre-visualized and dynamically evolves as you modify the extension length.

You could just as well enter the value directly in the Length field.

4. Click OK. The extended surface is created. Here are two views of the extending surface, illustrating the tangency constraint on the selected edge.

Using the Parametric option, and a value of 30%, you would have had the resulting surface:
Similarly, if an edge is selected, and the Curvature option active, the surface is extended according its initial curvature:

Check the Exact option if you want to switch to the Exact mode. The figures below show a surface extended when Exact mode is checked and unchecked.

- **Exact mode not checked**
- **Exact mode checked**

To extend a set of surface boundaries, you need to select these, using the Ctrl-key, before clicking the Extend icon .

In Parametric mode, you can choose to keep the initial surface (Keep option) or replace it by the extended surface.

In Tangential or Curvature mode:
- when the Exact option is checked, computation is analytical and the resulting surface presents the same degree as the initial surface. Since you chose this constraint, there may be no possible result in some cases.
- when the Exact option is not checked, the extrapolation is computed according to the geometric mode.

In Parametric, Tangential or Curvature mode, the curvilinear length between the middle of the selected original surface edge and the middle of the extended surface is displayed.
Up

4-Point Surface

Manipulating Surfaces

Blend Surfaces

Fill Surfaces

Extending Surfaces

Segmenting Surfaces

Planar Surfaces

Surface on Existing Surface

Rotating Surfaces

Styling Fillets

Offsetting Surfaces

Approximating Procedural Si

Redefining Surface Limits

Disassembling Surfaces

3-Point Surface

Editing Surfaces

Symmetric Surface

Matching Surfaces

Smoothing Surfaces

Extruding Surfaces

Restoring a Surface
Approximating Procedural Surfaces

In this task you will learn how to convert surfaces into NUPBS (Non Uniform Polynomial B-Spline) surfaces.

Open the approxim.CATPart document from the online/Samples/freestyle directory.

1. Select the surface to be approximated.
2. Click the Segmentation icon.

The Segmentation - Approximation dialog box is displayed allowing you to define the approximation according to a tolerance: this number is always 1 for surfaces.

When you select a procedural surface, the Type option switches to Approximation.
On the selected surfaces, segments are delimited by the solid lines. The displayed value is the number of segments (s:1 for example) and the order (0:4 for example) in both U and V direction for each patch, or the deviation between the initial surface and the pre-visualized surface, respectively for the Segments/Tolerance option chosen from the Segmentation dialog box.

3. Click More... to display more options or define the order values:
   - Check the Information option to display information on the deviation or on the number of segments.
   - Check the Control Points option to display control points.
   - The Smooth option enables you to smooth control points.

The values displayed on the surface are dynamically updated.

The system automatically
optimizes the numbers of segments to comply with the tolerance.

The Delta U and Delta V fields indicate the maximum delta U and delta V orders in relation to the initial surface.

4. Click OK. The surface modification is taken into account.

The surface multi-selection is available. However, you cannot mix the approximation of curves and surfaces. You need to perform their approximation separately.
Extruding Surfaces

In this task you will learn how to create a surface by extrusion from a curve. This can be any type of curve, such as planar curves, 3D curves, surface edges, or curves on surfaces.

Open the extrude.CATPart document from the online/Samples/freestyle directory.

1. Click the Extrude Surface icon .

2. Select the curve from which you want to extrude a surface.
   
   A manipulator is also displayed on the curve, oriented according to the 3D compass.
   
   The Extrude Options dialog box is displayed:
   
   - the Direction icon is the default icon and indicates the direction orthogonal to the curve plan.
   - the Compass icon enables you to manipulate elements using the 3D compass.
   - the Length field indicates the extrusion length.

   All the parameters entered in this dialog box are kept when the box is closed.

3. Click the manipulator on the curve and drag the pointer to extrude the surface in the given direction.

   When you press the Ctrl-key
while dragging the pointer, you can perform a symmetry.

The previewed extruded surface is dynamically displayed as you drag.

The segment number and the degree of the resulting surface are displayed:

- a full line indicates the segment limit
- a dashed line indicates the surface order

You can move back and forth between the compass and the surface to define the orientation after having extruded the surface, as long as you have not performed the final step.

4. Click OK to create the surface.

You can select the curve to be extruded before clicking the Extrude Surface icon or after.
Segmenting Surfaces

This task explains how to modify the number of patches (segments) on a surface.

Open the segment.CATPart document from the online/Samples/freestyle directory.

1. Select the surface to be segmented.
2. Click the Segmentation icon.

The Segmentation - Approximation dialog box is displayed allowing you to define the segmentation according to a set number of segments or to a tolerance: this number is always 1 for surfaces.

On the selected surfaces, segments are delimited by the solid lines. The displayed values are the number of segments (s:1 for example) and the order (0:4 for example) in both U and V direction for each patch, or the deviation between the initial surface and the pre-visualized surface, respectively for the Segments/Tolerance option chosen from the Segmentation dialog box.
3. Click More... to display more options or define the order values:
   - Check the Information option to display information on the deviation or on the number of segments.
   - Check the Control Points option to display control points.
   - The Smooth option enables you to smooth control points.
   - The values displayed on the surface are dynamically updated.

If you check the tolerance, the system automatically optimizes the numbers of segments to comply with the tolerance.

The Delta U and Delta V fields indicate the maximum delta U and delta V orders in relation to the initial surface.

4. Click OK.
   The surface modification is taken into account.

   The multi-surface selection is available. However, you cannot mix the segmentation of curves and surfaces. You need to perform their segmentation separately.
Redefining Surface Limits

This task shows how to redefine the limits of a surface by splitting it along one or more curves.

Open the curveonsurface.CATPart document from the online/Samples/freestyle directory.

1. Click the Curve on surface icon and create curves on the surface as described in Creating Free Form Curves on Surfaces.

2. Click OK to validate the curve you created.

3. Click the Break icon and select an area delimited by one of the curves to trim the initial surface.

Depending on the type of curve you create, you can choose one of the following break types in the Break Options dialog box:

- **Relimit**: the surface is relimited and the control points of the initial surface are kept.
- **Approximation**: the surface is not relimited and its limits are redefined. A new surface is created.
- **Exact**: the surface is exactly relimited.
Up

4-Point Surface
Manipulating Surfaces
Blend Surfaces
Fill Surfaces
Extending Surfaces
Segmenting Surfaces

Planar Surfaces
Surface on Existing Surface
Rotating Surfaces
Styling Fillets
Offsetting Surfaces
Approximating Procedural Si
Redefining Surface Limits
Dissembling Surfaces

3-Point Surface
Editing Surfaces
Symmetric Surface
Matching Surfaces
Smoothing Surfaces
Extruding Surfaces
Restoring a Surface
In this task you will learn how to restore the limits of a surface when it has been split using the Break icon (see Creating Free Form Curves on Surfaces).

Open the untrim.CATPart document from the online/Samples/freestyle directory, you can also use the resulting document from Creating Free Form Curves on Surfaces.

1. Select the surface which limits should be restored.

2. Click the Untrim icon in the Shape Modification toolbar.

The initial surface is automatically restored.

If the surface has been trimmed several times, it is the initial surface which is restored. To partially untrim the surface, you need to use the Undo command right after the trim.
In this task you will learn how to diassemble multi-cell bodies into mono-cell bodies.

Open any document containing a multi-cell body.

1. Select one of the surface edges.

2. Click the Diassemble icon in the Shape Modification toolbar.

The surface is still selected and you can delete it.

The surface is diassembled, that is to say the independent surfaces are created.

- The multi-selection is available.
- This function enables you to diassemble curves as well.
Analyzing Curves and Surfaces

This chapter deals with curve and surface analysis. Within the FreeStyle Shaper, analyses are elements that need to be explicitly deleted if you do not wish to keep them.

- Mapping an Environment on a Surface
- Analysis Using Isophotes
- Performing a Curvature Analysis
- Using Dynamic Cutting Planes
- Analyzing Distance Between Two Sets of Elements
- Mapping Analysis
- Draft Analysis
- Checking Connections Between Elements
Mapping an Environment on a Surface

This task explains how to map a sample environment onto a surface generated using the FreeStyle Shaper.

Open the analysis.CATPart document from the online/Samples/freestyle directory.

1. Click the Environment Mapping icon in the Shape Analysis toolbar.

   The Environment Mapping dialog box is displayed:

2. Define the type of mapping to be applied using the icon to the left, and the reflectivity coefficient with the slider.

   The preview area lets you fine-tune these parameters.

The surface automatically reflects your mapping definition. It could look like this:
Analysis Using Isophotes

This task explains how to apply isophotes on a surface. Isophotes are variable black stripes applied to the surface and used for analysis purposes. It is a tool for the analysis of the element state.

Open the analysis.CATPart document from the online/Samples/freestyle directory.

1. Click the Isophotes Analysis icon in the Shape Analysis toolbar.
   The Isophotes Mapping dialog box is displayed:

   ![Isophotes Analysis Icon]

2. Define the analysis parameters using sliders:
   - stripes number
   - width
   - color transition (smooth or sharp)

   The preview area is directly applied on the 3D screen and lets you fine-tune these parameters.
3. Define the orientation in space using three manipulators:
   - the two yellow spheres enable you to perform any orientation of the surface in space. You do so by clicking one of these spheres until you find the right orientation. The visualization is displayed directly on the surface in the Preview area.
   - a green sphere

If you want to orientate perpendicularly the surface, just click one of these three spheres.
If you want to undo the mapping on the 3D screen, click the **Clean** button.

If you want to reset the orientation perpendicularly to the Z axis, click the **Reset** button.

The surface automatically reflects your mapping definition. It could look like this:
Performing a Curvature Analysis

This task shows how to analyze the curvature of curves, or surface boundaries.

Open the analysis.CATPart document from the online/Samples/freestyle directory.

1. Click the Porcupine Curvature Analysis icon.

2. Select the curve.

   Automatically the curvature comb is displayed on the selected curve:

3. Define the analysis parameters in the Curvature Analysis dialog box: (Click More... to display all parameters.)

   The Automatic option optimizes the spikes length so that even when zooming in or out, the spikes are always visible.

   - Use the Project on Plane checkbox to analyze the projected curve in the selected plane referenced by the compass.

   - If you uncheck the Project On Plane option, the analysis is performed according to the curve orientation. This is the default option.
Use the Particular checkbox to display at anytime the minimum and the maximum points. The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in Curvature, if Radius option is selected.

4. Click Reverse, you will get something like this:

That is the analysis opposite to what was initially displayed. This is useful when from the current viewpoint, you do not know how the curve is oriented.

5. You can also decide to reduce the number of spikes in the comb clicking as many times as wished the /2 button.

This option is particularly useful when the geometry is too dense to be read but the resulting curve may not be smooth enough for your analysis needs.

You could just as well multiply the number of spikes using the X2 button.
6. Similarly, click the /2 button to fine-tune the amplitude (size) of the spikes, and re-compute the analysis curve accordingly.

In our example we show both the initial spike size and the halved spikes connected by the green analysis curves.

7. Finally, click the icon to display the curvature graph:

![Curvature Analysis Diagram](image)

The curvature profile and amplitude of the analyzed curve is represented in this diagram.

8. Slide the pointer over the diagram to display the amplitude at a given point of the curve, and click Close to hide the diagram. You can slide the pointer over the diagram and the 3D analysis.

9. Click Close in the Curvature Analysis dialog box once you are satisfied with the performed analysis.
Using Dynamic Cutting Planes

This task shows how to analyze a surface using parallel cutting planes. The intersection of the planes with the surface is represented by curves on the surface. From these curves, you can visualize the porcupine analysis. This analysis is dynamic, meaning that you can interactively modify a number or parameters to fine-tune the analysis.

Open the analysis.CATPart document from the online/Samples/freestyle directory.

1. Select the surfaces to be analyzed.
2. Click the Cutting Planes icon in the Shape Analysis toolbar.

A reference plane is displayed along with the default number of cutting planes, and the corresponding projected lines onto the selected surface.

The Cutting Plane dialog box is displayed.

You can define analysis parameters from this dialog box, that is:

- The plane in which the analysis is to be performed, using the three icons (Parallel Planes, Planes perpendicular to curves, Independent planes)
The boundaries of the set of planes (available in Parallel Planes mode only):

- **Automatic**: the analysis is performed based on all selected surfaces bounding boxes. The cutting planes are evenly distributed within this area, one being necessarily located on the reference plane if the Step option is active.

- **Manual**: the analyzed area is defined by the Start and End values.

**Number/Step**: choose whether you have a set number of planes or a distance (step) between two planes. In the latter case, the number of planes depends on the size of the analyzed area. This option is only available in Parallel Planes and Planes perpendicular to curves mode.

- **Start/End**: in manual mode, defines the distance at which the first (start) and last (end) cutting planes are located on the reference plane axis.
Options facilitating the analysis reading:

- Activates the display of spikes (curvature analysis) via the Curvature Analysis
- Activates/hides the representation of the cutting planes

3. Click the Parallel planes icon. The compass moves to the reference plane center, and from then you can manipulate the reference plane.

If you want to perform an analysis in planes perpendicular to curves, select a curve and click the Planes perpendicular to curves icon.
If you want to perform an analysis in independent planes, click the Independent planes icon.

4. Activate the Manual mode, set the Step value to 50, and the Start value to -150 and End value to 150. The planes are automatically relocated.

If you wish to analyze the curvature or radius of the intersection curves, simply click Curvature. The Curvature Analysis dialog box is displayed.

The result is similar to using the Porcupine curvature analysis, except that it displays spikes for
5. Click OK in the Cutting Plane dialog box, when you have finished the analysis.
   - Click OK to interrupt the function while keeping the analysis on the surface, so that it is dynamically updated when deforming the surface.
   - Click Cancel to interrupt the function and remove the analysis.
   - Right-click the intersection curves to actually create the curve on the analyzed surface. You can choose to create only the curve over which the pointer is (Keep this intersection curve option) or to "drop" all curves onto the element (Keep all intersection curves option).
Analyzing Distances Between Two Sets of Elements

This task shows how to analyze the distance between a cloud of points and a surface, but this analysis can be performed on any two sets of elements.

Open the analysis.CATPart document from the online/Samples/freestyle directory.

1. Select a surface.
2. Click the Distance Analysis icon in the Shape Analysis toolbar.

The Distance Analysis dialog box is displayed.

3. Select a target element.

This element is automatically discretized, except if you choose a cloud of points.

The distance analysis is computed.

Each color identifies all points located at a distance between two values displayed in the Distance Analysis dialog box.

Two analysis modes are available:

a. Full: provides a complete analysis based on the chosen color range. This allows you to see exactly how the evolution of the distance is performed on the selected element.

b. Quick: provides a simplified analysis, but lets you define the tolerance within which the distance deviation should be.

For example, for positive values, if the deviation is bigger than 0.010, the points are red, if the deviation is smaller than 0.010, the points are green.
If we change the first spinner to 20.0 in this example, the resulting geometry would be:

The Direction option helps you define the projection of the vector between the target point and the source element.
Using the 3D option, the vector itself is displayed
Using the X, Y or Z plane option, the vector is projected according to the selected axis
Using the compass option, the vector is projected according to the compass orientation.

6. Use the Display area to the distance representation: either the color is displayed on points, the spikes can be displayed and inverted, the envelope, that is the curve connecting all spikes together, the minimum and maximum values (Information option).

Finally, the Scaling option lets you define the visualization of the comb. In Automatic mode the comb size is zoom-independent and always visible on the screen, otherwise you can define a coefficient multiplying the comb exact value (distance).

7. Use the Discretization option to limit the number of points of the target element taken into account when computing the distance deviation.

In Full analysis mode, but with a discretization of 25, the results would look like this.

When the source element is a surface and the target a cloud of points, you can automatically delimit the target points to be taken into account for the computation by activating the Automatic trap, thus improving the performances.

8. Choose whether you wish to see the normal distance, that is distance between the target point and its normal projection onto the source element, or the minimum distance, that is the smallest distance from the target point to the source.

The normal distance may not exist, as shown on the end-points of the curve to the right.
9. Click OK to exit the analysis.
Performing a Mapping Analysis

This task shows how to analyze the mapping curvature of a surface.

Open the gaussanalysis.CATPart document from the online/Samples/freestyle directory.

The visualization mode should be set to Shading with Texture and Edges, and the discretization option should be set to a maximum (see Improving Performances, the 3D Accuracy -> Fixed option should be set to 0).

1. Select a surface.
2. Click the Mapping Analysis icon in the Shape Analysis toolbar.

The Curvature Analysis dialog box is displayed, and the analysis is visible on the selected element.

3. Choose the Linear option from the dialog box:
   Available options to display the color range are: linear, sharp left, sharp center, or sharp right.
   The values are ranging from 0 to 1, corresponding to the minimum and maximum Gaussian curvature respectively.
   The surface now looks like this:

4. Modify the values in the color range to highlight specific areas of the selected surface.
   To do this, click and drag the arrows delimiting the colors, or directly key in the values.

5. Click Close to exit the analysis capability, or Reset to come back to default values for the color range.
Gaussian analyses can be performed on a set of surfaces.
Double-click the arrows from the color range to display the color chooser allowing you to redefine the color range.
You can display the control points by clicking the icon, still viewing the Gaussian analysis. This allows you to check the impact of any modification on the surface according to the Gaussian analysis.
Performing a Draft Analysis

This task shows how to analyze the draft angle on a surface.

Open the draftanalysis.CATPart document from the online/Samples/freestyle directory. The visualization mode should be set to Shading with Texture and Edges, and the discretization option should be set to a maximum (see Improving Performances, the 3D Accuracy -> Fixed option should be set to 0).

In case of an obviously inconsistent result, do not forget to invert locally the normal direction via the On the fly analysis checkbox.

1. Select a surface.
2. Click the Draft Analysis icon in the Shape Analysis toolbar.

The Draft Analysis dialog box is displayed, and the analysis is visible on the selected elements.

You can modify the values in the color range to highlight specific areas of the selected surface. To do this, click and drag the arrows delimiting the colors, or directly key in the values. You can also choose a different display for the color range: Linear, Sharp left, Sharp center, or Sharp right.

The values are expressed in degrees, ranging from -90 to 90 degrees. You can modify them by clicking on their corresponding arrow or by entering a value directly in the field.

The precision for entering values is 0.1 degree.

The cursor manipulation for colors is limited between -20 et 20 but the analysis is performed between -90 and 90 degrees.

If you see no visualization on the selected element, move the pointers in the dialog box to redefine the draft values.
3. Activate the On the fly analysis checkbox and move the pointer over the surface. Arrows are displayed under the pointer, identifying the normal to the surface at the pointer location (green arrow). As you move the pointer over the surface, the normal display is dynamically updated.

If you click the green arrow (Normal) you can invert it. In this case, the draft analysis is not possible any longer, the whole surface became red (highest value).

If you click the red arrow, it freezes the location for the arrow allowing general manipulations according to the compass. The displayed value indicates the angle between the draft direction and the normal to the surface at the current point.

4. Bring the compass onto the selected surface, to locally manipulate it and have a different view of the analysis without modifying the analysis values. These values can be edited by double-clicking the compass which displays the Compass Manipulation dialog box.

5. You can display the control points by clicking the Control Points icon, yet the draft analysis is still visible, then allowing you to check the impact of any modification to the surface on the draft analysis.

6. Once you have finished analyzing the surface, click Close in the Draft Analysis dialog box.
If you have moved to another capability, you need to redisplay the Draft Analysis dialog box by clicking the Draft Analysis icon then to click Reset to remove the draft analysis from the element.

A draft analysis can be performed just as well on a set of surfaces. Double-click the arrows from the color range to display the color chooser allowing you to redefine the color range.
Checking Connections Between Elements

This task shows how to analyze how two surfaces are connected, following a blend, match, or fill operation for example.

Three types of analyses are available:
- **Distance**: the values are expressed in millimeters
- **Tangency**: the values are expressed in degrees
- **Curvature**: the values are expressed in percentage.

Open the `connectchecker.CATPart` document from the online/Samples/freestyle directory.

1. Select both surfaces to be analyzed.
2. Click the Connect Checker icon in the Shape Analysis toolbar.

   The Connect Checker dialog box is displayed identifying by color ranges the maximum and minimum values for the analysis. The color range can be Linear, Sharp left, Sharp right, or Center. The analysis representation in the color range varies according to the chosen option.

3. Choose the type of analysis to be performed: Distance, Tangency or Curvature.
4. Check the analysis results on the geometry.

   Here we are analyzing the distance between the surfaces. Each color section indicates on the geometry the distance between the surfaces.
From the Connect Checker dialog box, you can choose a number of visualization and computation options.

The Display lets you display:

- the comb: that is the spikes corresponding to the distance in each point
- the envelope: that is the curve connecting all spikes together
- some information: the minimum and maximum values

Finally, the scaling option lets you define the visualization of the comb. In automatic mode the comb size is zoom-independent and always visible on the screen, otherwise you can define a coefficient multiplying the comb exact value.

5. Check the Information button:

Two texts are displayed on the geometry localizing the minimum and maximum values of the analysis as given in the Connect Checker dialog box.

You can also choose the discretization, that is the numbers of spikes in the comb:

- Coarse: 15 spikes are displayed
- Medium: 30 spikes are displayed
- Fine: 45 spikes are displayed

6. Switch to Linear mode, and check the Fine discretization, and compare with the previous results.
7. Click the Quick button to obtain a simplified analysis taking into account tolerances (distance, tangency and curvature).

The comb is no longer displayed.
The Connect Checker dialog box changes to this dialog box.

8. Use the spinners to define the tolerances.

For example, the red area indicates all points that are distant of more than 0.1 mm, the green area indicates the points that are closer than 0.1 mm but at which the tangency difference is greater than 2 degrees.
The points that would match the first two tolerance constraints and at which the curvature difference would be greater than 5%, would appear in blue. There are none in this case.

The maximum deviation values on the current geometry are displayed to the right of the dialog box.

9. Click OK to create the analysis as an element in the specification tree.
This allows the automatic update of the analysis when you modify any of the surfaces, using the control points for example (see Editing Surfaces Using Control Points).
If you do not wish to create the analysis, simply click Cancel.

You can edit the color range in both dialog boxes by double-clicking the color range manipulators (Connect Checker) or color areas (Quick Violation Analysis) to display the Color chooser.
If you wish to edit the Connection Analysis, simply double-click it from the specification tree.
If you no longer need the Connection Analysis, right-click Connection Analysis in the specification tree, and choose Delete.

The curvature difference is calculated with the following formula:

\[ \frac{|C_2 - C_1|}{\frac{|C_1 + C_2|}{2}} \]

The result of this formula is between 0% et 200%.
Generic Tools

This chapter deals with generic tools available in FreeStyle Shaper.

Displaying Control Points

Stretch View Analysis Tool

Managing the Compass

Autodetection

Displaying Isoparametrics

Up

Opening a New CATPart Do Importing and Exporting Files

Creating and Managing Curv

Creating and Managing Surf

Analyzing Curves and Surf

Generic Tools
Displaying Control Points

This task shows you how to display or hide the control points on FreeStyle Shaper elements for analyses purposes.

Open any .CATPart document from the online/Samples/FreeStyle directory.

Click the Control Points Display icon or press F11.

The Visibility dialog box is displayed.

1. Select the element on which you wish to display the control points.

2. Click the Show option to display the control points.
   
   If you want to hide the control points, click the Hide option.

3. Click OK.
   
   The control points and mesh lines are displayed on the selected element.

- The display of control points remains as long as you do not access to the dialog box again to uncheck the Hide option.

- No modification is possible on the control points, as opposed to using the Control Points icon as described in Editing Surfaces Using Control Points or Editing Curves Using Control Points.

- Multi-selection applies with these display capabilities:
Displaying Isoparametrics

This task shows you how to display isoparametrics on FreeStyle Shaper elements for analysis purposes.

Open any document from the online/Samples/freestyle directory.

The Visualization Options dialog box is displayed.

1. Click the Isoparametrics Display icon.

2. Select the geometry on which you want to display isoparametrics.

3. Click the Isoparametrics option to display or hide the isoparametrics on the geometry.

4. Enter values in the Number in U and V fields.

The first field lets you modify the number of isoparametrics in U.

The second field lets you modify the number of isoparametrics in V.

The U and V values must not exceed 10.
By default, the last values you entered are displayed when you open the dialog box.

5. Click OK to display isoparametrics.

- In the case of a relimited geometry, the isoparametrics are not relimited.
- The display of isoparametrics remains as long as you do not access again to the dialog box again to uncheck the Isoparametrics option.
Managing the Compass

This task shows you how to quickly manage the compass orientation.

Press F5 or click the Flip compass base icon in the Generic Tools toolbar.

The Quick compass orientation toolbar is displayed.

Here are summarized the main features of its eight icons:

- Click the Flip to UV or XY, Flip to VW or YZ or Flip to WU or ZX icon to switch the compass base to the three planes of its trihedron.
  
  If the compass is "in" the main axes of the model, the icons indicate X, Y and Z otherwise U, V and W.

- Click the Most Seen Plane icon to activate and deactivate the Most Seen Plan mode.

- Click the Set Plane by Selection icon or press F6 to orientate the compass by selecting either an existing plane or three points (via the Autodetection command).

  The point selection is based on Autodetection parameters.
Click the Reset the Compass according to XYZ icon or press F7 to reset the compass parallel to the main axes (X, Y and Z) of the model.

This option is not active when the compass is already set according to the axes.

Click the In Model or on Perch icon to switch the compass from the perch to the model or vice versa.

The origin is kept in the model until the toolbar remains open.

Click the Create the Plane icon or press F8 to drop the compass plane, that is to create a plane corresponding to the compass basis.

This icon is activated only when the compass is in the model.

These four shortcuts (F5, F6, F7 and F8) are effective only when the Quick compass orientation toolbar is displayed. Therefore when you first hit one of the keys, the toolbar is displayed and the shortcuts are effective from then on.

The Quick compass orientation toolbar remains active until you close it by clicking the cross in the upper-right corner or, if you have activated it with the icon, by clicking the icon again.
This task shows how to use the stretch view tool prior while analyzing a FreeStyle Shaper element.

Stretching means distorting the space view, without affecting the element itself. It is especially useful to examine precisely the curvature of an element from different viewpoints and with specific angles. This stretching is done according to the X and Y axes taking the screen as a reference into the active window.

Open the stretch.CATPart document from the online/Samples/freestyle directory.

To make it more explicit, we choose to open two windows (Window -> New Window) and to display them horizontally (Window -> Tile Horizontally).

1. Select a surface and click to display the control points on the surface in both windows.
2. Click the Stretch View icon.

The control points temporarily disappear, and the Stretch View dialog box is displayed:

3. Activate the Auto Update option and modify the X and Y stretch values.
   In the example, we set the values to: X=2.2 and Y=4.
   The geometry looks like this:

   If you click Close, the control points are visible again and you can continue to deform the surface as you wish.

4. If you check the Isometric button, the geometry is stretched proportionally in both directions, meaning that you modify only the X value and the Y value is automatically updated.
   In our example, the stretch then is X=2.2 and Y=2.2.

5. Click Reset.
   The previous viewing settings are taken into account. The view no longer is stretched.
You could also stretch a specific area of the screen, using a trap.

The center of the trap (cross) becomes the center of the screen. Using the Ctrl-key, the trap center will be located where you click first.

The resulting stretch looks like this:

Whatever the stretch options you choose, you can continue to use any other FreeStyle Shaper or Optimizer capability. For example, you could apply the Curvature analysis. To the left the curvature analysis with no stretch, and to the right, the stretched curvature analysis.

If you do not choose the Auto Update option, set both stretch values then click Apply. Even the stretch is performed in reference to your screen (X is the horizontal axis and Y the vertical one), you can still manipulate the geometric elements as usual. You can rotate, move elements and so forth.
The Autodetection tool enables you to perform a remote point selection which is especially useful for selecting on the fly point on geometry.

1. Press F12 or click the Autodetection icon.

The Autodetection dialog box is displayed.

2. Define the type of search in the Search Mode area:
   - Click the Closest corner icon to detect the closest corner of the selected element.
   - Click the Closest border icon to detect the closest border (edge) of the selected element.
   - Click the Closest control point icon to detect the closest control point or segment of the selected element.

3. If you want to force snap, select the Snap checkbox.

4. The Display area enables you to display:
   - the point coordinates as the pointer moves along by selecting the Coordinates checkbox.
   - the remote mode dressing by selecting the Search dressing checkbox.

5. Click the Close button to perform the autodetection or the Reset button to define new parameters.
Advanced Tasks

**Theme**

- Using FreeStyle Shaper
- Using FreeStyle Optimizer
- Interoperability with Part Design
- Interoperability with Wireframe
Using the FreeStyle Shaper

Besides Basic User Tasks the FreeStyle Shaper provides a number of advanced tasks. More advanced tasks are available with the FreeStyle Optimizer (refer to Using the FreeStyle Optimizer).

Editing a Surface Boundary

Handling Clouds of Points

Interoperability with Part Des
Interoperability with Wirefr
Editing a Surface Boundary

This task explains how to modify a surface boundary as created in Creating Free Form Curves on Surfaces using its control points.

Open the curveonsurface.CATPart document from the online/Samples/freestyle directory.

1. Select the surface boundary you wish to edit.

2. Click the Control Points icon.

   Control points and lines are displayed along that boundary.

By default all control points are selected. Click a specific point to deform the boundary at this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection capabilities).

3. Modify the boundary pulling on its control points or the mesh line.

4. Click OK in the Control Points dialog box.

   The boundary is modified.

Only the boundary and its control points are modified. Any other boundary of the surface is not affected by these modifications.
Handling Clouds of Points

This task explains how to handle the selection of cloud of points for fitting purposes.

Open the curveonsurface.CATPart document from the online/Samples/freestyle directory.

1. Select the cloud of points.

2. Click the Point Selection icon.

   The Activation trap dialog box is displayed letting you define what kind of trap you wish to use to define selectable points (rectangular or polygonal), whether you wish to keep points inside or outside the trap as well as display options.

3. Define the options.

4. Draw the trap by clicking two points in the case of a rectangular trap or as many points as needed for a polygon shaped trap.

   The resulting point selection is automatically displayed.

   These points can now be used for fitting purposes for example (see Fitting a Curve to a Cloud of Points or Fitting a Surface to a Cloud of Points for example).
5. Click the Activate all button from the Activation Trap dialog box to restore the complete cloud of points.

6. Choose the Polygonal trap type.

7. Click as many points as needed to draw the trap and double-click to end its definition.

The results will be the initial cloud minus the contents of the trap if you selected the Inner points option, or as above, the contents of the trap if you choose the Outer points option.
Using the FreeStyle Optimizer

The FreeStyle Optimizer offers complementary capabilities to the FreeStyle Shaper. It is used on the same type of elements yet taking the design capabilities one step further.

Fitting a Curve to a Cloud of Points  Fitting a Surface to a Cloud of Points

Globally Deforming a Surface  Analyzing Reflect Curves

Interoperability with Part Des Interoperability with Wirefr
Fitting a Curve to a Cloud of Points

This command is only available with the FreeStyle Optimizer.

This task explains how to fit a curve to a cloud of points.

Open the fitcurve.CATPart document from the online/Samples/freestyle directory.

1. Select the curve you wish to deform by fitting it to the geometry.
2. Click the Fit to Geometry icon.
3. Select the target element, that is the element to which the curve should fit. Here, select the cloud of points.
4. Define the fitting parameters in the Fitting area of the Fit to Geometry dialog box.
   You need to specify the Curve tension, and Allowed smoothing that have to be taken into account when modifying the curve to fit the existing geometry.
5. Use the contextual menu on the Free text to impose boundary continuity constraints: Free, Point, Tangent or Curvature.
   This can be set for each end-point of the initial curve.
6. Click Fit to accept the definition, once all parameters have been defined. The curve is modified so as to fit as best the selected geometry, while taking the fitting parameters into account.

7. Click OK in the Fit to Geometry dialog box to accept the new curve as fitted to the cloud of points.
   - Use the Ctrl-key to select several curves to be fitted at a time.
   - You can iterate and click Fit several times. This lets you fine-tune the fit.
This command is only available with the FreeStyle Optimizer.

This task explains how to fit a surface to a cloud of points.

Open the fitsurface.CATPart document from the online/Samples/freestyle directory.

1. Click the Fit to Geometry icon 🖼.
2. Select the surface, or set of surfaces, you wish to deform by fitting them to the cloud of point.
3. Right-click the Free text on which you want to impose edge constraints.

You can choose from four constraint types:
- Free: no constraint is imposed on this boundary
- Point: the resulting surface will still pass through the boundary of the initial surface
- Tangent: the edge of the resulting surface will be tangent to the initial surface at the selected boundary
- Curvature: the resulting surface will be continuous in curvature with the initial surface at the selected boundary.
4. Define the deformation parameters from the Fit to Geometry dialog box:
   - Tension: indicates which tension coefficient is applied
   - Smoothing: defines the smoothing coefficient to be applied.

5. Click Targets and select the target element in the geometry.
6. Click Fit, the surface is projected onto the target geometry.
   
   You can repeat the operation and deform the surface step-by-step.
7. When the results are satisfying, click OK in the Fit to Geometry dialog box.

The new surface fits the pre-existing cloud of points.

You can also choose to impose a direction when fitting the surface to the cloud of points meaning that the surface will be projected according to cloud of points, as shown to the left below, and no longer according to the normals to the initial surface, as shown to the right.

Using this item you can fit a surface to a cloud of points just as well as you can fit it to any other type of pre-existing geometry.
Globally Deforming a Surface

This command is only available with the FreeStyle Optimizer.

This task explains how to deform a set of surfaces in one operation.

Open the globaldeformation.CATPart document from the online/Samples/freestyle directory.

1. Select the surfaces to be deformed, using the Control key for multi-selection.
2. Click the Global Deformation icon.

The 3D compass is displayed along with the Global Deformation dialog box into which you can specify deformation options: using an intermediate patch or a user-defined axis.
In this case, use the default option: intermediate patch (Intermediate surface use icon).

If you click the Intermediate surface use icon, the Control Points dialog box is displayed:
Use it to define the type of operation to be performed on the control points.

- Support defines the type of translation to be applied
- Law defines the type of deformation that is to be applied when several control points have been selected.

3. Click Run in the Global Deformation dialog box.

A transparent patch with control points and mesh lines is displayed. It represents the intermediate surface bounding box.

4. Use the control points and the mesh lines of the planar patch to deform it. The space transformation is defined between the initial patch and the deformed patch.

All surfaces are automatically and dynamically deformed according to this intermediate patch deformation.
The final deformed surface looks like this.

If you choose the **1 guide** option:

1. Select a guide.

2. Click **Run** in the Global Deformation dialog box. The Control Points dialog box is displayed. Use the control points and mesh lines to deform the surface.

3. Click **OK** in the Control Points dialog box.

   The deformation is performed along the selected guide.
If you choose the 2 guides option:

1. Select two guides using the Ctrl-key.

2. Click Run in the Global Deformation dialog box. The Control Points dialog box is displayed. Use the control points and mesh lines to deform the surface.

3. Click OK in the Control Points dialog box.

The deformation is performed along the two selected guides.
Analyzing Reflect Curves

This command is only available with the FreeStyle Optimizer.

This task explains how to apply reflect curves onto a surface for analysis purposes.

Open the manipulate.CATPart document from the online/Samples/freestyle directory.

1. Select one or more surface(s).

2. Click the Reflection Lines icon.

A grid of neons is displayed above the surface. Each neon is represented by a red line. It is an endless neon, and reflect lines are displayed in red over the surfaces.

The Reflection dialog box is displayed from which you can define a number of parameters:

- The Analysis type
- The number of Neons and the spacing between any two neons.
- The viewpoint:
  - according to the current 3D viewer. When you move the geometry in space, reflect lines are re-computed according to the new viewpoint
  - according to the user-defined viewpoint. In this case, when you move the geometry in space, reflect lines do not move but you can move the eye.
- The position: this option automatically calculates the position of the neon grid (according to the surfaces).
3. Move the pointer above one of the points around the grid of neons to display a rotation direction and an axis.

4. Click the dot and still holding the mouse-key down, slide the pointer over the rotation axis.

Reflect lines on the surface evolve as you modify the position of the grid of neons, allowing you to analyze the reflection onto the surface.

5. You can select and deselect the analyzed surfaces.

6. Once you are satisfied with your analysis, simply click OK in the Reflection dialog box.

- A Reflect Lines Analysis is created in the specification tree. You can therefore create several such analyses on different sets of surfaces or on the same set of surfaces but using a different viewpoint.
- As reflect line analyses are objects as such, they can be edited using the contextual menu in the specification tree for example.
Interoperability with the Part Design Workbench

You can work in the FreeStyle Shaper/FreeStyle Optimizer workbench only, creating forms and modifying them. However in an industrial environment, it is always useful to have integrated design tools at one's disposal. The integration between the FreeStyle Shaper workbench and the Part Design workbench is described in the chapter, based on a step-by-step scenario composed of several tasks illustrating how to work with both surface and body type elements, that is elements created using the Part Design workbench.

<table>
<thead>
<tr>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Sketch and a Pad</td>
</tr>
<tr>
<td>Creating a Surface</td>
</tr>
<tr>
<td>Splitting the Pad</td>
</tr>
<tr>
<td>Modifying the Splitting Surface</td>
</tr>
<tr>
<td>Updating the Part</td>
</tr>
</tbody>
</table>

This scenario is accomplished in six minutes.

The resulting body will look like this:
Creating a Sketch and a Pad

This task explains how to create a pad from a sketch in the Part Design Workbench.

Open a new .CATPart document (see Opening a new CATPart Document) and activate the Part Design Workbench.

1. Click the Sketcher icon.
2. Select xy plane to define the sketch plane.
3. Click the Circle icon.
4. Click where you wish the center of the circle to appear.
5. Drag the pointer to see the circle being created.
   A rubberbanding circle follows the pointer as you drag it.
6. Click once you are satisfied with the size of the circle.
7. Click the Exit Sketcher icon then the Pad icon.
   A default cylindrical pad is previewed.
8. Key in 200 in the power input entry area, and click OK to create the pad.

A cylindrical pad has been created using the Part Design workshop.
Creating a Surface

This task will show you how to enter the FreeStyle Shaper workbench.

1. Now, choose FreeStyle from the Start menu. The FreeStyle Shaper workbench is displayed.

2. Move the existing cylinder so as to see only one of its face.

3. Select the Planar patch icon.

4. Click at the center of the cylinder (where you clicked to create the circle sketch) press the Ctrl-key and drag the pointer so as to cover the cylinder face by the blue outline.
5. When you have reached the adequate size, click again.

The corresponding surface has been created in a plane parallel to that defined by the 3D compass.

See [Creating Planar Patches](#) for further details on the 3D compass capabilities and on creating planar surfaces.

6. Select the surface and drag it halfway of the cylinder length pulling on the z axis.

The body now looks like this:
Splitting the Pad

This task will show you how to split the cylinder by the surface.

1. Now, choose Part Design from the Start menu. The Part Design workbench is displayed again.
2. Select the cylinder and click the Split icon.
3. Select the created surface as the splitting plane.
   An arrow appears indicating the portion of body that will be kept, make sure that it points in the right direction.
4. Click OK in the Split Definition dialog box.
   The cylinder has been split by the surface.
Modifying the Splitting Surface

This task will show you how to modify the splitting surface.

1. Return to the FreeStyle Shaper workbench.

2. Select the surface and click the Control points icon then the middle top law icon (Stretch selected points) from the Control Points dialog box.

   Control points and mesh lines are displayed.

3. Move the pointer over an edge mesh line and pull down so as to manually deform the surface.

   If needed, refer to Editing Surfaces Using Control Points for further details on surface modification.

4. Click OK in the Control Points dialog box.
Updating the Part

This task will show you how to update the split cylinder.

1. Return to the Part Design workbench.
2. Select the split cylinder.
3. Click the Update icon.

The cylinder is automatically split by the new surface shape.
Interoperability with the Wireframe Workbench

You can work in the FreeStyle Shaper/FreeStyle Optimizer workbench only, creating forms and modifying them. However in an industrial environment, it is always useful to have integrated design tools at one’s disposal. The integration between the FreeStyle Shaper workbench and the Wireframe workbench is described in the chapter, based on four tasks illustrating how to create wireframe geometry using the Wireframe workbench.

**Tasks**
- Creating Points
- Creating Lines
- Creating Planes
- Creating Circles
Creating Points

This task shows the various methods for creating points in the Wireframe Workbench:

- by coordinates
- on a curve
- on a plane
- on a surface
- at a circle center
- tangent points on a curve.

1. Click the Point icon.

The Point Definition dialog box appears.

2. Use the combo to choose the desired Point type.

Coordinates

- Enter the X, Y, Z coordinates.

  The corresponding point is displayed.

On curve

- If this point is not on the curve, it is projected onto the curve.

  Select a Curve
  Optionally, select a reference Point.

  - If no point is selected, the curve’s extremity is used as reference.
Use the Distance to reference area to determine whether the new point is to be created:

- a given distance along the curve from the reference point
- a given ratio between the reference point and the curve’s extremity.

Enter the Length or Ratio value. The corresponding point is displayed.

You can click the Nearest extremity button to display the point at the nearest extremity of the curve.

You can click the Middle Point button to display the mid-point of the curve.

You can use the Reverse Direction button to display:

- the point on the other side of the reference point (if a point was selected originally)
- the point from the other extremity (if no point was selected originally).

The Remove reference point icon enables you to remove the reference point to use the default one.

On plane

Select a plane.
Optionally, select a point to define a reference for computing coordinates in the plane.

If no point is selected, the projection of local axis system’s origin onto the plane is taken as reference.

Click the plane to display a point.
On surface
- Select the surface where the point is to be created.
- Optionally, select a reference point.
- Select a line to take its orientation as reference direction or a plane to take its normal as reference direction.
- You can also use the contextual menu to specify the X, Y, Z components of the reference direction.
- Enter a distance along the reference direction to display a point.

Circle center
- Select a circle or circular arc.

A point is displayed at the circle center.

Tangent on curve
- Select a curve and a direction line.

A point is displayed at each tangent.

3. Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.
Creating Lines

This task shows the various methods for creating lines in the Wireframe Workbench:

- point to point
- point and direction
- angle or normal to curve
- tangent to curve
- normal to surface

1. Click the Line icon.

   The Line Definition dialog box appears.

2. Use the combo to choose the desired Line type.

   A line type will be proposed automatically in some cases depending on your first element selection.

Point - Point

- Select two points.

   The corresponding line is displayed.

Point - Direction

- Select a reference Point and a Direction line.

   A vector parallel to the direction line is displayed at the reference point.
   Proposed Start and End points of the new line are shown.

- Specify the Start and End points of the new line.

   The corresponding line is displayed.

Start and End points are specified by entering distance values or by using the graphic manipulators.

You can reverse the direction of the line by either clicking the displayed vector or selecting the Reverse Direction button.
**Angle normal to curve**
- Select a reference Curve and a Support surface containing that curve.
- Select a Point on the curve.
- Enter an Angle value.

A line is displayed at the given angle with respect to the tangent reference curve at the selected point. These elements are displayed in the plane tangent to the surface at the selected point. You can click the Normal to Curve button to specify an angle of 90 degrees. Proposed Start and End points of the line are shown.

- Specify the Start and End points of the new line.

The corresponding line is displayed.

**Tangent to curve**
- Select a reference Point and a Curve.

A vector tangent to the curve is displayed at the reference point. Proposed Start and End points of the new line are shown.

- Specify Start and End points to define the new line.

The corresponding line is displayed.
Normal to surface

- Select a reference Surface and a Point.

  A vector normal to the surface is displayed at the reference point. Proposed Start and End points of the new line are shown.

- Specify Start and End points to define the new line.

  The corresponding line is displayed.

3. For most line types, you can select the Geometry on Support check box if you want the line to be projected onto a support surface. In this case, just select a support surface.

The figures below illustrate this case.

The line (identified as Line.xxx) is added to the specification tree.
Creating Circles

This task shows the various methods for creating circles and circular arcs in the Wireframe Workbench:

- center and radius
- center and point
- two points and radius
- three points
- bitangent and radius
- bitangent and point
- tritangent

1. Click the Circle icon.

   The Circle Definition dialog box appears.

2. Use the combo to choose the desired circle type.

   Center and radius
   - Select a point as circle center.
   - Select the support plane or surface where the circle is to be created.
   - Enter a radius value.

   Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. For a circular arc, you can specify the Start and End Angles of the arc.

   If a support surface is selected, the plane tangent to the surface at the selected point is
used.

Start and End
Angles can be
specified by
entering values or
by using the
graphic
manipulators.

**Center and point**
- Select a point as circle center.
- Select a point where the circle is to pass.
- Select the support plane or surface where the circle is to be created.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End Angles of the arc.

**Two points and radius**
- Select two points where the circle is to pass.
- Select the support plane or surface where the circle is to be created.
- Enter a radius value.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two selected points as end points.

You can use the Second solution button to display the alternative arc.
Three points

- Select three points where the circle is to pass.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. For a circular arc, you can specify the trimmed or complementary arc using the two selected points as end points.

3. In each of the methods above, you can select the Geometry on Support checkbox if you want the circle to be projected onto a support surface.

In this case, just select a support surface.

Bitangent and radius

- Select two curves to which the circle is to be tangent.
- Select a support surface.
- Enter a radius value.
- Several solutions may be possible, so click the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points.

Bitangent and point

- Select two curves to which the circle is to be tangent.
- Select a point on the second curve.
- Select a support plane or surface.
- Several solutions may be possible, so click the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle

Complementary trimmed circle

Tritangent

Select three curves to which the circle is to be tangent.
Select a support surface.
Several solutions may be possible, so click the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points.

4. Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
Creating Planes

This task shows the various methods for creating planes in the Wireframe Workbench:

- from its equation
- through three points
- through two lines
- through a point and a line
- through a planar curve
- tangent to a surface
- normal to a curve
- offset from a plane
- parallel through a point
- at an angle to a plane
- mean plane through several points

1. Click the Plane icon .
   The Plane Definition dialog box appears.
2. Select the Plane type.

Once you have defined the plane, it is represented by a red square symbol, which you can move using a graphic manipulator.

**Equation**
- Enter the A, B, C, D components of the $Ax + By + Cz = D$ plane equation.

**Through three points**
- Select three points.

The plane passing through the three points is displayed.
Through two lines

Select two lines.

The plane passing through the two line directions is displayed.

Through point and line

Select a Point and a Line.

The plane passing through the point and the line is displayed.

Through planar curve

Select a planar Curve.

The plane containing the curve is displayed.

Tangent to surface

Select a reference Surface and a Point.

A plane is displayed tangent to the surface at the specified point.
Normal to curve

- Select a reference Curve and a Point.

A plane is displayed normal to the curve at the specified point.

Offset from plane

- Select a Reference plane then enter an Offset value.

A plane is displayed offset from the reference plane.

Parallel through point

- Select a Reference plane and a Point.

A plane is displayed parallel to the reference plane and passing through the selected point.

Angle or normal to plane

- Select a Reference plane and a Rotation axis.
- Enter an Angle value.
- Click the Normal to plane button if you want to specify that an angle of 90 degrees is to be used to define the new plane.

A plane is displayed passing through the selected axis. It is oriented at the specified angle to the reference plane.
Mean through points

Select three or more Points to display the mean plane through these points.

It is possible to edit the plane by first selecting a point in the dialog box list then choosing a button by either:

- remove the selected point.
- replace the selected point by another point.

3. Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
Workbench Description

In this Chapter we will describe the various menus, submenus, items and toolbars of the FreeStyle Shaper and FreeStyle Optimizer workbench.

<table>
<thead>
<tr>
<th>Theme</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Describes the FreeStyle Shaper and Optimizer menu bar</td>
</tr>
<tr>
<td>Creation Toolbars</td>
<td>Describe the curve and surface creation toolbars</td>
</tr>
<tr>
<td>Modification Toolbar</td>
<td>Describes the modification toolbar and cloud handling toolbar</td>
</tr>
<tr>
<td><strong>Analysis Toolbars</strong></td>
<td>Describe analysis toolbar and the viewing toolbars used as an aid to analyses</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Generic Tools Toolbar</strong></td>
<td>Describe the tools toolbar</td>
</tr>
</tbody>
</table>
Menu Bar

This section presents the tools and commands which are available in the FreeStyle Shaper and FreeStyle Optimizer workbench.

Many other operations are documented in the *CATIA Version 5 Infrastructure User's Guide*.

<table>
<thead>
<tr>
<th>Start</th>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Insert</th>
<th>Tools</th>
<th>Windows</th>
<th>Help</th>
</tr>
</thead>
</table>

### File

The File menu lets you perform file creation, opening, saving, printing operations.

For... See ...

- **New...** Ctrl+N  
- **Open...** Ctrl+O  
- **Close**
- **Save** Ctrl+S  
- **Save As**  
- **Save All**
- **Print...** Ctrl+P  
- **Contents...**
- **Exit**

### Edit

The Edit menu lets you manipulate selected objects. Refer to the CATIA *Infrastructure* and *Part Design* documentation.

### View

The View menu lets you view document contents. Refer to the *CATIA Infrastructure* documentation.

### View - Toolbars

For... See...

- Standard  
- Workbench  
- View  
- Apply Material  
- Measure
WireFrame Toolbar

By default, the WireFrame toolbar is hidden.

For... See...

Point  Creating Points
Line   Creating Lines
Plane  Creating Planes
Circle Creating Circles

Insert

The Insert menu lets you insert FreeStyle Shaper and Optimizer elements.

Open Body

The Open Body option lets you insert an open body in the 3D tree.
Shape Modification

For...
Mirror Symmetry
Control Points
Match Surface
Match Curve
Fit to Geometry
Global Deformation
Segmentation
Break
Untrim
Disassemble
Offset
Extend

See...
Creating a Symmetric Curve and Creating a Symmetric Surface
Editing Curves Using Control Points, Editing a Surface Boundary and Editing Surfaces Using Control Points
Matching Surfaces
Matching Curves
Fitting a Curve to a Cloud of Points and Fitting a Surface to a Cloud of Points
Globally Deforming a Surface
Segmenting Curves and Segmenting Surfaces
Redefining Surface Limits
Restoring a Surface
Diassembling Surfaces
Offsetting Surfaces
Extending Curves and Extending Surfaces

Surface Creation

For...
Planar Patch
3-Point Patch
4-Point Patch
Geometry Extraction
Blend Surface
Styling Fillet
Extrude Surface
Fill

See...
Creating Planar Patches
Creating a Surface from Three Points
Creating a Surface from Four Points
Creating a Surface on an Existing Surface
Creating Blend Surfaces
Creating Styling Fillets Between Surfaces
Extruding a Surface
Filling in Between Surfaces

Curve Creation

For...
Curve on Plane
Curve on Surface
Curve in Space
Project Curve
Blend Curve

See...
Creating Free Form Curves on Plane
Creating Free Form Curves on Surfaces
Creating Free Form Curves in Space
Projecting Curve
Creating Blend Curves
# Shape Analysis

<table>
<thead>
<tr>
<th>Feature</th>
<th>For...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Checker</td>
<td></td>
<td><a href="#">Checking Connections Between Elements</a></td>
</tr>
<tr>
<td>Porcupine Analysis</td>
<td></td>
<td><a href="#">Performing a Curvature Analysis</a></td>
</tr>
<tr>
<td>Cutting Planes</td>
<td></td>
<td><a href="#">Using Dynamic Cutting Planes</a></td>
</tr>
<tr>
<td>Reflection Lines</td>
<td></td>
<td><a href="#">Analyzing Reflect Curves</a></td>
</tr>
<tr>
<td>Distance Analysis</td>
<td></td>
<td><a href="#">Analyzing Distance Between Two Sets of Elements</a></td>
</tr>
<tr>
<td>Mapping Analysis</td>
<td></td>
<td><a href="#">Performing a Mapping Analysis</a></td>
</tr>
<tr>
<td>Draft Analysis</td>
<td></td>
<td><a href="#">Performing a Draft Analysis</a></td>
</tr>
<tr>
<td>Environment Mapping</td>
<td></td>
<td><a href="#">Mapping an Environment on a Surface</a></td>
</tr>
<tr>
<td>Isophotes Analysis</td>
<td></td>
<td><a href="#">Analysis Using Isophotes</a></td>
</tr>
</tbody>
</table>

# Cloud Handling

<table>
<thead>
<tr>
<th>Feature</th>
<th>For...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Selection</td>
<td></td>
<td><a href="#">Handling Clouds of Points</a></td>
</tr>
</tbody>
</table>

# Generic Tools

<table>
<thead>
<tr>
<th>Feature</th>
<th>For...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Points Display</td>
<td>F11</td>
<td><a href="#">Displaying Control Points</a></td>
</tr>
<tr>
<td>Isopar Display</td>
<td>F10</td>
<td><a href="#">Displaying Isoparametrics</a></td>
</tr>
<tr>
<td>Stretch View</td>
<td>F9</td>
<td><a href="#">Stretch View Analysis Tool</a></td>
</tr>
<tr>
<td>Flip compass base</td>
<td>F5</td>
<td><a href="#">Managing the Compass</a></td>
</tr>
<tr>
<td>Set compass orientation</td>
<td>F6</td>
<td><a href="#">Managing the Compass</a></td>
</tr>
<tr>
<td>Reset compass to XYZ</td>
<td>F7</td>
<td><a href="#">Managing the Compass</a></td>
</tr>
<tr>
<td>Drop compass plane</td>
<td>F8</td>
<td><a href="#">Managing the Compass</a></td>
</tr>
<tr>
<td>Autodetection</td>
<td>F12</td>
<td><a href="#">Autodetection</a></td>
</tr>
</tbody>
</table>

# Tools

The Tools menu lets you perform image capture and album management, set user preferences and manage macros. Refer to the [CATIA Infrastructure](#) documentation.

# Window

The Window menu lets you arrange document windows in relation one to the other. Refer to the [CATIA Infrastructure](#) documentation.

# Help

The Help menu lets you get help on the currently active command, and the product in general. Refer to the [CATIA](#) documentation.
Infrastructure documentation.
Creation Toolbars

The creation toolbars contain the following tools:

See [Creating Planar Patches](#)

See [Creating a Surface from Three Points](#)
See [Creating a Surface from Four Points](#)

See [Creating a Surface on a Existing Surface](#)

See [Extruding a Surface](#)

See [Creating Blend Surfaces](#)

See [Creating Styling Fillets on Surfaces](#)
See [Filling in Between Surfaces](#)

See [Creating Free Form Curves on Plane](#)

See [Creating Free Form Curves on Surfaces](#)

See [Creating Free Form Curves in Space](#)

See [Projecting Curves](#)

See [Creating Blend Curves](#)
Modification Toolbars

The modification toolbar contains the following tools:

- See **Manipulating Surfaces** and **Rotating a Surface**
- See and **Creating a Symmetric Surface**
- See **Editing Curves Using Control Points**, **Smoothing Curves**, **Editing Surfaces Using Control Points** and **Smoothing Surfaces**
- See **Matching Surfaces**
- See **Matching Curves**
- See **Fitting a Curve to a Cloud of Points** and **Fitting a Surface to a Cloud of Points**
- See **Creating Blend Surfaces**
- See **Segmenting Curves** or **Segmenting Surfaces**
- See **Redefining Surface Limits**
- See **Restoring a Surface**
- See **Disassembling Surfaces**
- See **Offsetting Surfaces**
- See **Extending a Surface**
- See **Handling Clouds of Points**
Analysis Toolbar

The analysis toolbar contains the following tools:

See [Checking Connections Between Elements](#)

See [Performing a Curvature Analysis](#)

See [Using Dynamic Cutting Planes](#)

See [Analyzing Reflect Curves](#)

See [Analyzing Distance Between Two Sets of Elements](#)

See [Performing a Mapping Analysis](#)

See [Performing a Draft Analysis](#)

See [Mapping an Environment on a Surface](#)

See [Analysis Using Isophotes](#)
Generic Tools Toolbar

The generic tools toolbar contains the following tools:

See Displaying Control Points

See Displaying Isoparametrics

See Stretch View Analysis Tool

See Managing the Compass

See Autodetection
Customizing

This section describes how to customize different settings. All tasks described here deal with permanent setting customization. These tasks are:

- Improving Performances
- Viewing FreeStyle Shaper Elements
## Glossary

### Special Characters

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D compass</td>
<td>The 3D compass is a three-axis system used to define the plane into which any action is performed. It is displayed whenever you are creating an element or applying modifications to this element.</td>
</tr>
<tr>
<td>approximation</td>
<td>A surface or a curve is converted into a NUPBS surface or a NUPBS curve.</td>
</tr>
<tr>
<td>blend curve</td>
<td>A curve created to connect two pre-existing curves.</td>
</tr>
<tr>
<td>blend surface</td>
<td>A surface created to connect two pre-existing surfaces.</td>
</tr>
<tr>
<td>cloud of points</td>
<td>A set of points in space. A cloud of points may consist of a single point or several million points.</td>
</tr>
<tr>
<td>global deformation</td>
<td>A deformation that is applied globally to a set of elements, as opposed to a deformation successively applied to different elements.</td>
</tr>
<tr>
<td>isophote</td>
<td>A line or surface on a chart forming the locus of points of equal illumination or light intensity from a given source.</td>
</tr>
<tr>
<td>match curve</td>
<td>A curve deformed so as to connect another curve, while taking the continuity type into account.</td>
</tr>
<tr>
<td>match surface</td>
<td>A surface deformed so as to connect another surface, while taking the continuity type into account.</td>
</tr>
<tr>
<td>mesh line</td>
<td>A line on a surface used to deform this surface according to various laws, and types of deformation.</td>
</tr>
<tr>
<td>reflect line</td>
<td>Line visualized on a surface, that reflects the light emanating from a grid of neon located above the surface.</td>
</tr>
</tbody>
</table>
Index

Numerics

3D compass ➤
  choosing orientation ➤

A

analysis
  connection ➤
  curvature ➤
  curvature on surface ➤
  cutting plane ➤
  distance ➤
  draft ➤
  isophotes ➤
  mapping ➤
  reflect lines ➤
  approximate procedural curves or procedural surfaces ➤, ➤

B

breaking
  surface ➤, ➤

C

checking connections ➤
cloud of points
  fitting to ➤
  trap ➤
commands
  3 Points Patch ➤
4 Points Patch
Autodetection ,
Blend Curves
Blend Surface
Break Surface or Curve ,
Circles
Cloud-Surface Deviation
Compass Management
Connect Checker
Control Points ,
Cutting Planes
Disassemble
Draft Analysis
Environment Mapping
Extrude
Fill
Fit to Geometry ,
Global Deformation
Isoparametrics Display
Isophotes Analysis
Lines
Mapping Curvature
Match Curves
Match Surface
Mirror Symmetry ,
Offset
Planar Patch
Planes
Points
Porcupine Curvature Analysis
Reflect Lines
Rotate
Segmentation ,
Select
Stretch View
Styling Fillet
Untrim Surface or Curve
control points, curvature
fitting constraint, surface
curves
blend, creating in plane, creating on surface, creation orientation, lying on existing geometry, matching, modifying, segmenting, smoothing, splitting, trimming, symmetric
cutting planes
full analysis, relative analysis

deforming
surface, draft analysis

environment mapping, extending
curve, surface, extruding
surface

F

fillet
filling
  between surfaces
fitting
  surface to other geometry
  target element
fitting constraint
  curvature
  free
  point
  tangent
Free
  fitting constraint

G

global deformation

I

isophotes

M

mapping analysis
mirror
  surface
Offsetting

Part Design
  working with
Performance
Point
  fitting constraint

Reference elements visualization
reflect line
restoring
  surface
rotating
  surface

Smoothing
  surface
Specification tree
styling fillet
surfaces
  break
  deviation analysis
diassembling
extrude
fill
fitting to geometry
global deformation
modifying, rotation, segmenting, smooth, splitting, symmetric, translation, untrim, symmetry, curve, surface, tangent, fitting constraint, target, fitting to, translate, surface, tree view, wireframe, working with